
 
 
 
 
 

 
 
 
 

PDF-eXPLODE v3

 
2013

 
 
 
 
 
 



 

 

Table of Contents
Welcome to PDF-eXPLODE ...........................................................................................................................4

License Agreement ...................................................................................................................................6
End-User License Agreement ............................................................................................................7
How Licensing Works .......................................................................................................................11
Network Licensing ............................................................................................................................12

About PDF-eXPLODE ............................................................................................................................13
General Overview .............................................................................................................................14
How PDF-eXPLODE Works .............................................................................................................15
Benefits of PDF ................................................................................................................................16
Example Applications .......................................................................................................................17
Frequently Asked Questions ............................................................................................................18
What's New in Version 2 ..................................................................................................................23
What's New in Version 3 ..................................................................................................................25

Installing ..................................................................................................................................................27
System Requirements ......................................................................................................................28
Install PDF-eXPLODE ......................................................................................................................29
Multi-user Administration ..................................................................................................................31
What's Installed Where .....................................................................................................................33
Remove PDF-eXPLODE ..................................................................................................................34

Purchasing & Registering .......................................................................................................................35
Trial Version ......................................................................................................................................36
Purchase Online ...............................................................................................................................37
Register Online .................................................................................................................................39

Getting Started Tutorials .........................................................................................................................40
Create a PDF File ............................................................................................................................41
Explode a PDF File ..........................................................................................................................42
E-mail a PDF File .............................................................................................................................43
Automate the Process ......................................................................................................................45

Reference ................................................................................................................................................46
Start PDF-eXPLODE ........................................................................................................................47
Main Menu ........................................................................................................................................48
Specifying Options ............................................................................................................................49

General Settings .........................................................................................................................50
Completed Processing Notification ............................................................................................53
Logging and Utilities ...................................................................................................................54
Variable Settings .........................................................................................................................56
PDF Security Settings ................................................................................................................58
Mail Settings ...............................................................................................................................61
Default Message ID Tags ...........................................................................................................64
Client Details ...............................................................................................................................67
Client-specific Message ID Tags ................................................................................................71
HTML Editor ................................................................................................................................75

Preparing a Document .....................................................................................................................78
PDF-eXPLODE Tag ....................................................................................................................79
Text-based Documents ...............................................................................................................81

Microsoft Word ......................................................................................................................82



 

 

Data-driven Documents ..............................................................................................................83
Crystal Reports .....................................................................................................................84
Microsoft Access ...................................................................................................................85
Microsoft Word Mail Merge ..................................................................................................86
R&R Report Writer ...............................................................................................................87

Printing to PDF-eXPLODE ...............................................................................................................88
Print Options ...............................................................................................................................89
Logging Operations ....................................................................................................................91

Command Line Usage ......................................................................................................................92
Run PDF-eXPLODE from a Command Line ..............................................................................93

Technical Support ...................................................................................................................................94
System Requirements ......................................................................................................................95
Advanced Configuration ...................................................................................................................96

PDF File Creation Properties .....................................................................................................97
PDF-eXPLODE Website ...................................................................................................................99

Mail Settings ...............................................................................................................................................100



 

 

 

Welcome to PDF-eXPLODE
Version 3.3.13.99 (SP 3 / Revision 13) June 2013

 
PDF-eXPLODE automates the document delivery process for businesses. It turns paper and electronic documents into secure e-mails that can be batch-sent

to business clients, customers, patients, employees, vendors, investors and others saving time and money.  PDF-eXPLODE is perfect for sending invoices,

statements, form letters and other reports and correspondence.

 

System Requirements

• Operating System: Microsoft® Windows® XP, Windows 2000, Windows Server® 2003, Windows Server® 2008, Windows Vista® or Windows 7
• Hard Drive: Minimum 52.5MB of free disk space, plus additional space for PDF files created
• RAM: At least 64MB of available memory, more during PDF creation. The size of the PDF that can be created is limited by the amount of available

memory.

 

Before Getting Started
Please note the following configuration items before getting started:

• If you are NOT using Letter size paper: The default paper size supported by PDF-eXPLODE is Letter.  If your paper size is different, for example

A4, you must edit the PDF File Creation Properties and set the appropriate Paper Size before proceeding.
• If you are using PDF-eXPLODE on a network shared computer: There are special considerations and configuration settings when using PDF-

eXPLODE in a shared environment such as Terminal Services, Citrix, BusinessObjects, Crystal Reports Server, SQL Server Reporting Services or as a

network shared printer. These are discussed in the topic on Multi-user Administration.

• If you want to purchase a license online: Purchase this software online.
• If you already purchased a license and want to activate it online: Activate online License ID.

 

Getting Started
If you are eager to send your first PDF-eXPLODE e-mail within the next few minutes, follow the Fast Start Guide and then come back to the tutorials below to

learn more when time permits.  If you prefer to read a technical overview of PDF-eXPLODE before getting started, see the section below.

• Fast Start Guide

If you are new to PDF-eXPLODE, please follow the Getting Started Tutorials to quickly learn how to use PDF-eXPLODE and achieve the results you desire. 

Each tutorial will take approximately 10 minutes.

Tutorials

• Create a PDF File
• Explode a PDF File
• E-mail a PDF File
• Automate the Process

If you are currently using PDF-eXPLODE Version 1 or Version 2 and are upgrading to Version 3, the following topics describe the new features.

• What's New in Version 2
• What's New in Version 3
• What's new in this v3.3.13.99

 
Technical Overview
PDF-eXPLODE software comprises two programs, a Setup Program and a Windows Printer.



 

 

PDF-eXPLODE Setup Program

The PDF-eXPLODE Setup Program is used to configure PDF-eXPLODE settings including General settings for the program's operation, Mail settings for creating

and sending e-mails, Security settings for applying passwords to PDF files, and Message and Client settings for customizing e-mails for specific types of

documents or specific recipients. 

 
Some settings are required while others are optional.  All settings are stored in an 'INI' file, the location of which is described on the help topic What's

Installed Where. If you are going to be using PDF-eXPLODE on a network shared computer, please review Multi-user Administration for important information.

 
The PDF-eXPLODE Setup Program may be accessed from the PDF-eXPLODE folder available under Programs on the Windows Start menu, or by clicking

the shortcut optionally installed on your Windows desktop.

PDF-eXPLODE Windows Printer

The PDF-eXPLODE Windows Printer program emulates a physical printer and receives printer output from your application when you select Print from

the File menu within your application. Printer output is converted into a PDF file, which in turn may be exploded into separate PDF files based on specially

formatted tags located within the document. 

 
PDF files are saved in a specified folder with the name specified by the tag, and are then optionally e-mailed as a file attachment with a specified e-mail

subject and message. E-mail settings come from a configuration file created and maintained by the Setup Program described above. 

 
The PDF-eXPLODE Windows Printer may be accessed from the Printers and Faxes folder available under Settings on the Windows Start menu. To confirm

the PDF-eXPLODE printer is working properly, right-click PDFeXPLODE, select Properties and click Print Test Page. A PDF file containing the Windows

printer test page will be created in the Default Document Path.
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 End-User License Agreement
LICENSE AGREEMENT AND LIMITED WARRANTY

 
IMPORTANT-READ CAREFULLY: This End-User License Agreement ("EULA") is a legal agreement between you
("Licensee") and 3000AD SYSTEMS PTY LTD ("Licensor"). For purposes of this EULA, the term "Software Product" shall
mean all PDF-eXPLODE software and documentation, electronic and printed, individually and as a group, and the term
"License" shall mean the right to make, use, or access a particular copy of the Software Product.
The Software Product is protected by copyright laws and international copyright treaties, as well as other intellectual property
laws and treaties. The Software Product is licensed, not sold.
 
By installing, copying, or otherwise using the Software Product, you agree to be bound by the terms of this EULA. If
you do not agree to the terms of this agreement and the accompanying EULA, you may not install or use the Software
Product.
 
SOFTWARE PRODUCT LICENSE
 
1.0  GRANT OF LICENSE
Licensor, grants Licensee a non-exclusive and limited license to use the Software Product accompanying this EULA, solely in
accordance with the terms and conditions of this EULA. The Software is licensed, not sold, to Licensee.
 
2.0  INSTALLATION AND USE
 
2.1  Single User License
Licensee may install and use a single copy of the Software Product on a single computer as long as that computer is owned by
Licensee and/or used solely by an employee of Licensee. Licensee may access the Software Product strictly in accordance with
the terms hereof. Licensee must acquire additional single user licenses for additional users to use the Software Product.

2.2 Network License
This EULA grants you a limited, non-exclusive license to install the SOFTWARE onto one Network Server  provided the
appropriate Network License (namely: PDF-eXPLODE Report Server, PDF-eXPLODE Printer Sharing Server or PDF-eXPLODE
Citrix /Terminal Server) has been purchased. "Network Server" means a computer with one or more computer central processing
units (CPU's) that operates for the purpose of serving other computers logically or physically connected to it, including, but not
limited to, other computers connected to it on an internal network, intranet or the Internet. You are strictly prohibited from
installing a Single User license product on a Network, unless approved in writing by Licensor.
 
2.3  Trial License
Licensee may use one copy of the Software Product on a single computer, for a limited period as provided by the Software
Product. Licensee is acquiring only the limited right to use a single copy of the Software Product for evaluation purposes.
Licensee does not acquire any rights to the Software Product itself.
 
3.0  DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS
 
3.1  Separation of Components
The Software Product is licensed as a single user product and may be installed on a single computer accessible only by a
single user.
 



 

 

3.2  Upgrades
If the Software Product is labeled as an upgrade, Licensee must be properly licensed to use a product identified by Licensor
as being eligible for the upgrade in order to use the Software Product. A Software Product labeled as an upgrade replaces
and/or supplements the product that formed the basis for eligibility for the upgrade. Licensee may use the resulting upgraded
product only in accordance with the terms of this EULA. If the Software Product is an upgrade of a component of a package of
software programs licensed as a single product, the Software Product may be used only as part of that single product package
and may not be separated for use on more than one computer.
 
3.3  Rental
Licensee may not rent, lease, or lend the Software Product.
 
3.4  Support Services
Licensee must register with Licensor or its Agent in order to be eligible for technical support via electronic mail. Licensee is
entitled to support via email from Licensor, free of charge. Subject to that provision, support is provided free of charge at the
Licensor's sole discretion. The Licensor reserves the right to revoke or modify support provided for the Software at any time,
for any or no reason. The Licensor also reserves the right to provide software support at an hourly rate of US$80 per hour if it
deems necessary. Any supplemental software code provided to Licensee as part of support services shall be considered part
of the Software Product and subject to the terms and conditions of this EULA. With respect to technical information Licensee
provides to Licensor as part of any such support services, Licensor may use such information for its business purposes,
including for product support and development. Licensor will not utilize such technical information in a form that personally
identifies Licensee.
 
3.5  Software Transfer
Notwithstanding any terms to the contrary, Licensee may not transfer rights under this EULA. In view of the fact that Licensee
has acquired the right to use the Software Product under special terms, any transfer of rights under this EULA is strictly
prohibited.
 
3.6  Ownership
Licensee agrees that 3000AD Systems Pty Ltd and/or its Suppliers, retains all right, title and interest in and to the Software
Product and all copies at all times, regardless of the form or media in or on which the original or other copies may
subsequently exist. Licensee agrees they neither own nor hereby acquire any claim or right of ownership to the Software
Product or to any related patents, copyrights, trademarks or other intellectual property. Licensee agrees to use reasonable
efforts to prevent and protect the contents of the Software Product from unauthorized disclosure or use. Any data, content or
information accessed through the Software Product is the property of the applicable data/content/information owner and may
be protected by applicable copyright law. This EULA gives Licensee no rights to such data, content or information.
 
3.7  Copyright
All title and copyrights in and to the Software Product (including but not limited to any images, photographs, animations,
video, audio, music, text, and "applets" incorporated into the Software Product), and any copies of the Software Product are
owned by Licensor unless otherwise indicated. The Software Product is protected by copyright laws and international treaty
provisions. Therefore, the Software Product must be treated like any other copyrighted material.
 
3.8  U.S. Government Restricted Rights
The Software Product is provided with RESTRICTED RIGHTS. Use, duplication, or disclosure by the Government is subject
to restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause at DFARS
252.227-7013 or subparagraphs (c)(1) and (2) of the Commercial Computer Software-Restricted Rights at 48 CFR 52.227-19,
as applicable.
 
3.9  Other Restrictions
Licensee agrees not to alter, disassemble, decompile, translate, adapt or reverse-engineer the Software Product or make any
attempt to discover the source code of the Software or otherwise reduce the Software Product to a human perceivable form, or



 

 

to modify, network, or create derivative works based upon the Software Product in whole or in part, nor permit any other party
to do so.
 
3.10 Termination
Without prejudice to any other rights, Licensor may terminate this EULA if Licensee fails to comply with the terms and
conditions of this EULA. In such event, Licensee must destroy all copies of the Software Product and all of its component
parts.
 
4.0  MISCELLANEOUS
 
This EULA is governed by the laws of the Commonwealth of Australia in the State of New South Wales (NSW). Should you
have any questions concerning this EULA, or if you desire to contact Licensor for any reason, please contact Licensor at +612
9983-0367 or mail@3000ad.com.au.
 
5.0  LIMITED WARRANTY
 
Licensor warrants that the:

(i) Software Product will perform substantially in accordance with the applicable user documentation published by
Licensor for a period of ninety (90) days from the date Licensee first acquired Software Product, and
(ii) Support Services provided by Licensor shall be substantially as described in the applicable user documentation
published by Licensor, and Licensor will make commercially reasonable efforts to solve problem issues. Some states
and jurisdictions do not allow limitations on duration of an implied warranty, so the above limitation may not apply. To
the extent allowed by applicable law, implied warranties on the Software Product, if any, are limited to ninety (90) days.
Notwithstanding the foregoing, Licensor under no circumstances warrants the media on which the Software Product has
been distributed.

 
6.0  CUSTOMER REMEDIES
 
Licensee's exclusive remedy shall be, at Licensor's option, either

(i) return of the price paid, if any, or
(ii) replacement of the Software Product upon proof of purchase.

This Limited Warranty is void if failure of the Software Product has resulted from accident, abuse, or misapplication. Any
replacement Software Product will be warranted for the remainder of the original warranty period or thirty (30) days, whichever
is longer.
 
7.0  NO OTHER WARRANTIES
 
To the maximum extent permitted by applicable law, 3000AD Systems Pty Ltd and its Suppliers disclaim all other warranties
and conditions, either express or implied, including, but not limited to, implied warranties of merchantability, fitness for a
particular purpose, title, and non-infringement, with regard to the software product, and the provision of or failure to provide
support services. This limited warranty gives you specific legal rights. You may have others, which vary from state to state and
jurisdiction to jurisdiction.
 
8.0  LIMITATION OF LIABILITY
 
To the maximum extent permitted by applicable law, in no event shall 3000AD Systems Pty Ltd (or its Suppliers) be liable
for any special, incidental, indirect, or consequential damages whatsoever (including, without limitation, damages for loss of
business profits, business interruption, loss of business information, or any other pecuniary loss) arising out of the use of or
inability to use the software product or the provision of or failure to provide support services, even if licensor has been advised
of the possibility of such damages. In any case, 3000AD Systems Pty Ltd's (or its Suppliers') entire liability under any provision
of this EULA shall be limited to the greater of the amount actually paid by you for the software product or US $5.00. Because
some states and jurisdictions do not allow the exclusion or limitation of liability, the above limitation may not apply to you.

mailto:mail@3000ad.com.au
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PDF-eXPLODE License
The PDF-eXPLODE Single-user license is defined in the End-User License Agreement and usage over a network is clarified in Network Licensing. The

intention is for each license to allow for use in either of the following two environments:

• on a standalone PC or network workstation by any number of end-users using the computer locally

 
- or -

 
• on a network server or network shared computer by a single end-user or terminal.

 
PDF-eXPLODE licenses are also available to allow multiple users to share PDF-eXPLODE in the following three configurations:

• PDF-eXPLODE Terminal Server License: Covers a specified number of concurrent users under Microsoft Terminal Services or a Citrix Server

product
• PDF-eXPLODE Printer Server License: Covers a specified number of concurrent users with PDF-eXPLODE configured as a shared printer
• PDF-eXPLODE Report Server License: Allows PDF-eXPLODE to be used from a report server such as Business Objects Enterprise, Crystal Reports

Server or SQL Server Reporting Services (SSRS)

 
How Licensing Works
PDF-eXPLODE licensing is implemented via software that restricts usage to the specific computer on which the software is activated. Using electronic license

activation, a trial version is converted to a fully functional, registered and licensed version. Using this approach saves you time and makes license compliance

easy for your organization.

• After installing the trial version, you already have the complete PDF-eXPLODE software installed -- you simply need to activate it to remove the trial

version limitations.
• When you purchase a license to use PDF-eXPLODE, you receive an e-mail with a License ID and Password.
• The confirmation e-mail is sent immediately upon credit card authorization as part of the invoicing process.
• At the end of the purchase process, you may enter your License ID and Password into PDF-eXPLODE or you may activate your license the next time

you open PDF-eXPLODE.
• Upon activation, you have a fully functional, registered and licensed version.

 

Upgrade Licensing
Upgrading from an older version of PDF-eXPLODE follows a similar process to licensing a new version. Begin by uninstalling the older version and then follow

the steps above.  When you purchase a license, select the appropriate upgrade license. You may only purchase as many upgrade licenses as you have licenses

of the older version. Upon activation of the newer version license, the older version license will be invalidated.

 



 

 

Network Licensing
The following statement clarifies the End-User License Agreement provision in paragraph 2.1 for product usage in any of the following network environments:

 

• Application Server Network (e.g. Microsoft Terminal Services or Citrix XenServer™)
• Client-Server Network (e.g. Microsoft Windows Network)
• Peer-to-Peer Network (e.g. Windows shared printer)

 
The Software Product must not be used in any network unless multiple Licenses are purchased reflecting the actual number of separate end users or terminals

(whichever is the larger) accessing the Software Product on the network.



 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

About PDF-eXPLODE



 

 

General Overview
PDF-eXPLODE makes it faster, easier and less expensive to distribute business documents to your business clients. You can send invoices, statements and

other reports and correspondence. It is designed to get the right information to the right people at the right time, improving customer service, accelerating

cash flow and reducing costs.

Instead of manually printing, collating, stamping and distributing stacks of mail, printing to PDF-eXPLODE can automatically e-mail batches of individualized

documents with a single mouse click.

Clicking the printer button in a report writer, word processor or a mail-merge application activates PDF-eXPLODE.  PDF-eXPLODE explodes, or splits, a

document into individualized PDFs, which it then e-mails securely and reliably to your business clients.

PDF-eXPLODE  is easy to set up and use because it works with the programs you already know, like Crystal Reports, Microsoft Access and Microsoft Word, as

well as with most packaged software applications designed for managing your business.



 

 

How PDF-eXPLODE Works
PDF-eXPLODE functions as a Windows printer, so the document delivery process starts with the click of a printer button.

PDF-eXPLODE then runs through a series of three steps to create and distribute targeted emails. It:

1. Takes a report or a word or mail merge document and, instead of printing it, converts it to a master PDF document;
2. “Explodes,” or splits, the master PDF into individual PDF attachments based on e-mail tags in the original document; and
3. Distributes each individual PDF either via e-mail, your local area network or FTP (available soon) to the designated recipients or locations.
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Benefits of PDF
PDF-eXPLODE generates Adobe PDF (Portable Document Format) files from virtually any Windows application capable of printing. Adobe PDF is readable

across all major computing platforms, making your documents accessible to anyone using free Adobe Reader® software. There are many benefits to using the

PDF format to distribute your documents:

• Preserve the appearance of your documents so that the electronic and paper versions look identical.
• Protect the integrity of your documents by making them non-editable.
• Make it easy to copy and paste information from your documents into other office productivity applications.
• Add security to restrict access and prevent copying and pasting information from your documents.
• Compress your documents for more efficient delivery and storage.
• Take advantage of industry-wide support for Adobe PDF.



 

 

Example Applications
Invoices

PDF-eXPLODE is used by a manufacturing company who prides itself on providing exceptional customer service. Part of the company strategy is to offer

customers the option to receive automated e-mails containing order acknowledgements, shipping memos and invoices. These reports are sent daily.

This function used to be performed manually. A staff member would print all the order acknowledgements, shipping memos and invoices each day and mail or

fax each one to each customer. It was an expensive and labor-intensive process, and was subject to error, staff availability and time constraints.

PDF-eXPLODE is now used in combination with R&R Report Writer and Windows Scheduled Tasks to automatically send the requested reports each night,

ensuring that customers receive timely and accurate information about their orders.

To distribute the invoices, the database field containing the recipient’s e-mail address was inserted into the page header – in white so it’s invisible on the final

communication.  The report was set to print to the printer named “PDF-eXPLODE.” From there, the process is automated. When the report is printed, PDF-

eXPLODE stores the output (all invoices) in a PDF file and then sends each invoice to the correct customer.

Statements

PDF-eXPLODE is used by a laser toner cartridge recycling company who is driving up profitability by speeding up cash flow and freeing up staff to work on

revenue generation activities.

Producing and delivering monthly statements  used to be performed manually by a staff member who would print more than one thousand monthly

statements and a cover letter, spending hours collating the documents and stuffing envelopes, applying labels and finally mailing them, sometimes as long as

six weeks following the end of the month.

PDF-eXPLODE is now used in combination with Crystal Reports to automatically send the monthly statements on the first day of each month for the prior

month, ensuring that customers receive timely and accurate information about their accounts.

To distribute the statements, a form letter was written in Crystal Reports, and the statement was inserted as a subreport.  The database field containing the

customer's e-mail address was inserted in the page header with the color set to white to hide it on the finished document. By printing to the printer named

“PDF-eXPLODE”, thousands of statements are sent out automatically, helping this company work more efficiently.  In fact, the CFO has calculated that the

company will save $700 each time the statements are sent by PDF-eXPLODE.

 



 

 

 
Frequently Asked Questions
What It Does

What is PDF-eXPLODE?

PDF-eXPLODE is a one-click batch e-mail delivery tool that makes it easy and cost-effective for small businesses to get their customers the information they

expect on time. Through a click of the printer button, PDF-eXPLODE converts a report or a Word document into batches of individual PDF attachments and

securely and reliably e-mails them to the designated recipients. In addition, users can pre-schedule routine mailings for hands-free delivery.

What Are the Key Benefits of PDF-eXPLODE?

PDF-eXPLODE is designed to strengthen your business relationships by getting the information people need into their hands when they expect it.  Whether

sending daily confirmations, monthly statements, or other critical reports or correspondence, PDF-eXPLODE reduces costs and saves time by eliminating the

labor-intensive process of hand-mailing or e-mailing each document separately.  PDF-eXPLODE helps reduce costs, save time, increase cash flow and enhance

customer service.

How Does It Save Time and Decrease Costs?

PDF-eXPLODE software improves productivity and costs by eliminating the need to send documents one-by-one, whether through the mail or by e-mail. It:

• Eliminates costly and inefficient paper-based workflows.
• Offers customers, partners and employees immediate access to the information they need.
• Pre-schedules routine and tedious mailings, freeing up staff to focus on revenue-generating activities.

It also adds value to your existing business systems. Most organizations already have made costly investments in software and equipment and can't afford

new technologies that disrupt their current workflows. Thanks to its standards-based interface, PDF-eXPLODE software can work with any existing business

application.

• As a printer driver, it easily installs onto existing Windows computers via the Printer Control Panel.
• It supports e-mail delivery of documents using SMTP (Simple Mail Transport Protocol) standards.
• It works with your existing business applications, including Crystal Reports, R&R Report Writer, Microsoft Word ( and Mail Merge Wizard),

Microsoft Visual FoxPro, plus accounting and other software packages.

How Does It Increase Customer Satisfaction and Retention?

PDF-eXPLODE enables you to create focused, targeted documents, so you can treat your customers and partners as individuals, leaving them both satisfied

and loyal. It:

• Customizes documents, such as financial statements and marketing brochures, for specific individuals or even departments and workgroups –

sending them only the information they want and need.
• Allows you to send communications whenever you want for no additional cost so you can be responsive to your customers' needs.
• Combines multiple documents to the same recipient in a single PDF.
• Ensures that dynamically generated documents, including business reports and sales letters, are highly legible and consistently branded.
• Includes visually rich charts and graphs tailored to specific documents.
• Enhances your document delivery with targeted e-mail messages.

Who Benefits from PDF-eXPLODE?

Everyone you do business with will benefit from PDF-eXPLODE. Communication is central to the success of a business, and customers expect – and demand –

regular, consistent communication. PDF-eXPLODE makes it easy and affordable to get the right information into the right hands at the right time. That means

customers – as well as business partners and your employees – will remain well informed and, subsequently, confident about and satisfied with how you do

business.

PDF-eXPLODE helps companies communicate reliably, efficiently and regularly not only with their customers and outside vendors but also with and among

departments. PDF-eXPLODE allows departments as well as workgroups – purchasing, operations and accounting, for example – to simultaneously receive

business-critical reports, so they can continue to coordinate to keep the business running smoothly and efficiently.

What Are Its Business Applications?

PDF-eXPLODE can be used in virtually any business and by any department that sends bulk individualized communications – whether to customers,

employees, vendors or prospects.

Below is a sampling of the most popular uses for PDF-eXPLODE.

Manufacturing/Shipping and Fulfillment
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• Order confirmations
• Shipping memos

Accounting and Finance

• Invoices
• Account statements
• Contracts
• Purchasing orders
• Dunning letters
• Internal budget status reports

Human Resources Departments

• Benefits statements
• Open enrollment forms

Sales and Marketing

• Targeted sales letters
• Promotional mailings
• Thank you notes
• Re-order solicitations
• Internal lead status reports
• Regional sales reports

Professional Services

• Billing statements
• Appointment confirmations
• Reminders to schedule appointment

Financial Service Providers

• Monthly, quarterly, year-end statements
• Trade confirmations
• Portfolio management and reviews

How Is PDF-eXPLODE Different from Other Document Distribution Tools?

PDF-eXPLODE is an all-in-one document delivery tool that allows you to both create individual PDFs and e-mail them in batches with a click of your printer

button.

What Are the Key Features of PDF-eXPLODE?

Easy Use and Set-up – PDF-eXPLODE can be used with both text documents and data-driven reports, seamlessly fitting into business workflows. PDF-

eXPLODE works with most business applications, including Crystal Reports, R&R Report Writer, Microsoft Access and Microsoft Word (Mail Merge Wizard),

Microsoft Visual FoxPro, and accounting and other software packages. As a printer driver, it installs onto any Windows computer via the Printer Control Panel.

Automatic and Manual Process Settings – PDF-eXPLODE can be set in silent mode to run without intervention when a document is printed, whether whether

from within an application by clicking the printer button or from a task scheduler for true hands-free processing. Or it can be set to run manually for full

control to set options at any time, displaying interactive pop-up instructions that users respond to every step of the way.

Standard and Customized E-mail Messages – PDF-eXPLODE defaults to a general e-mail subject and message to make e-mail deliveries as easy and hands-

free as possible. For enhanced customer service, it allows customization of e-mail subjects and messages for each individual PDF attachment. In addition,

users can crate and name pre-scripted e-mail messages - such as "Invoice" or "Monthly Statement" - to sent to all recipients of a similar type of document to

easily manage report distribution to multiple customers.

Multiple Delivery Modes – PDF-eXPLODE can distribute individual PDF attachments through a number of communications channels. In addition to sending

through e-mail, it can send documents to shared network folders for employees to view. In the near future, PDF-eXPLODE will have the capability to send PDF

documents to FTP sites for Web publishing. 
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Streamlined Mailings Management and Archiving – PDF-eXPLODE has a number of features for managing mailings. It logs each task performed for job

verification so users can review the results of each e-mail and correct any errors. It also saves a copy of each PDF attachment for archiving.

Professional Benefits of PDF Format – PDF-eXPLODE leverages the features and benefits of Adobe PDF. In addition to making documents accessible to anyone

using free Adobe Reader® software, it preserves the professional appearance of original documents so the electronic and paper versions look identical. It

protects the integrity of documents by making them non-editable. It also offers efficiency, making it easy to copy and paste information from documents into

other office productivity applications.

Secure Sending – PDF-eXPLODE has a number of security features that protect the integrity of documents, including the ability to select whether a recipient

can edit the PDF document. In addition, it allows users to password-protects files to further secure their communications.

Efficient Operations – PDF-eXPLODE efficiently sends documents directly through a mail server (SMTP) instead of using an e-mail client, such as Outlook or Notes. This

feature avoids having to manually confirm pop-up security-block messages. It also provides a choice of e-mail From: address, so e-mails can be sent from any address. It also

compresses documents for more efficient delivery and storage.

Bonus PDF Creation – While the main purpose of PDF-eXPLODE is to create and distribute batches of PDF documents, it can turn any individual document,

such as an Excel spreadsheet, into a PDF without sending.

How It Works

How Does PDF-eXPLODE Work?

PDF-eXPLODE functions as a Windows printer, so the document delivery process starts with the click of a printer button.

 

PDF-eXPLODE then runs through a series of three steps to create and distribute targeted e-mails. It:

1. Takes a report or a word or mail merge document and, instead of printing it, converts it to a master PDF document;

2. “Explodes,” or splits, the master PDF into individual PDF attachments based on hidden e-mail tags in the original document; and

3. Distributes each individual PDF either via e-mail, your local area network or FTP (available soon) to the designated recipients.

What Are the System Requirements for PDF-eXPLODE?

PDF-eXPLODE is ideally suited to work with any application that merges data from a database with a template, including Crystal Reports, R&R Report Writer,

Microsoft Access, Microsoft Word (Mail Merge Wizard), Microsoft Visual FoxPro and other "report writer" software, either built-in to your business applications

or used as a separate add-on to your business databases.   You also may use PDF-eXPLODE with any Windows application that is capable of printing if you

wish to e-mail all or portions of the document or if you simply want to convert a document to PDF format.

System Requirements

• Operating System: Microsoft® Windows® XP, Windows 2000
• Hard Drive: Minimum 34MB of hard disk space
• RAM: At least 16MB of free RAM

Will PDF-eXPLODE Combine Documents Going to the Same Recipient?

Yes. PDF-eXPLODE merges all the documents “tagged,” or addressed, to the same recipient into one PDF attachment, which it then e-mails.

Can I Send a Document to More than One Recipient?

Yes. PDF-eXPLODE lets you send a single document to as many recipients as you like. This feature is helpful to keep everyone in the loop.

Can I Customize the e-mail Messages for Each PDF Attachment?

Yes. You can create and send a specific e-mail message with a specific PDF attachment. This is done by creating and saving a subject/message in a client

folder and then “tagging” the original document with specific file name of the subject/message. You may also create a mail merge using variables in the e-mail

subject and message.

Can I Manually Go Through the Delivery Process Step-by-Step?
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Yes. PDF-eXPLODE can run manually so that you have full control to set options for a mailing at any time. Instead of running automatically in “Silent Mode,”

PDF-eXPLODE will display interactive pop-up instructions that you respond to every step of the way. Using Silent Mode is a great way to automate the process

to run in the background while you work on other tasks or to run according to a schedule.

How Does PDF-eXPLODE Know Where to Send a Document and What Message Should be Sent?

PDF-eXPLODE reads hidden “tags” in the original document to know where to send the attachment and what message to include in the e-mail. These tags

include a recipient identifier – which is usually an e-mail address – and a message identifier. If a message identifier is not included, the e-mail attachment is

automatically sent with the default message you indicated when you initially set up PDF-eXPLODE.

How Do I “Tag” a Document?

You insert a "tag" on each page of the document that you want to be processed by PDF-eXPLODE. Typically, the tag is placed on the first line in the page

header. For a complete description and examples of of PDF-eXPLODE tags refer to the help topic PDF-eXPLODE Tag. Below is a summary of rules concerning

tags:

• A tag must adhere to the following general format:<pdfexplode>variables%messageIdentifier#clientIdentifier</pdfexplode>
• All tags must start (“open”) with <pdfexplode> and end (“close”) with </pdfexplode>.
• Open and close tags must match one another in case (i.e. uppercase, lowercase or mixed case).
• All tags must always include a client identifier, which may be an e-mail address or a filename.
• You may optionally specify multiple e-mail addresses separated with a comma (,) or semicolon (;).
• An optional message identifier, if used, must precede the client identifier and be followed by a pound sign (#).
• You may optionally precede the message identifier, if used, or client identifier with up to five variables followed by a percent sign (%). 

Variables must be separated with a comma (,).
• Tags must be formatted with the Arial font, and the color may be set to White to hide the tag.
• All tags must fit entirely on one line. Reduce the font size if necessary to fit on one line.
• You may include multiple tags per page.

Does “Tagging” a Document Differ Depending on the Business Application?

Yes - the steps you follow to insert a PDF-eXPLODE tag depends on the application in which you are working.

• Tagging a Microsoft Access Document
• Tagging a Microsoft Word Document
• Tagging a Microsoft Word Mail Merge Document
• Tagging a Crystal Report
• Tagging an R&R Report

How Do I Know If a Document Has Been Sent?

You can check on whether a document has been sent one of two ways.

1. You can view the “Log File,” which records and displays each action, so you can see if all documents were sent – and which ones, if any,

had sending errors.
2. You also can look in the e-mail inbox for your e-mail return address (i.e., Sender Name) account for delivery errors returned by the

intended recipient's e-mail server.

How Do I Specify the Location Where PDF Archive Files are Saved?

• The default file name is the client identifier in the <pdfexplode> tag and the default folder is specified in General Settings. 
• The default file name and folder may be overridden for a specific document type, using the Exploded File Name option on a Default Message ID Tag

screen, for a specific recipient on a Client Details screen or for a client-specific document on a Client-specific Message ID Tag screen.
• The file name and folder may be further customized from within the application printing to PDF-eXPLODE using variables. This feature allows report

writers to conditionally specify the file and folder names.

Can I print a PDF from the command line?

• Yes - use the Program Processing option on the Completed Processing Notification screen to call Foxit Reader from the Program folder and print a

PDF. Foxit Reader is a PDF viewer supplied with PDF-eXPLODE. Foxit Reader supports the following print options:
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/p <PDF

FileName>

Print specified document with the default printer

/t <PDF

FileName>

<Printer>

Print specified with the designated printer

For example, you may need to either print or e-mail Invoices. You could create two PDF-eXPLODE Default Message IDs, PrintMe and EmailMe. In

Crystal Reports (or another report writer) you could create a formula to compute the <pdfexplode> tag. The formula would be something like:

If Trim({DB_Email_Addr}) = "" Then "<pdfexplode>PrintMe#</pdfexplode>" Else "<pdfexplode>EmailMe#" + {DB_Email_Addr} + "</pdfexplode>"

The EmailMe message ID could specify the e-mail subject and message and the folder where the exploded PDF exploded files are saved. The PrintMe

message ID could specify the printer on which to print the selected invoices.

Can I perform a file clean-up operation after PDF-eXPLODE processing?

Yes 3000AD SYSTEMS can provide a Cleanup.exe program on e-mail request (mail@3000ad.com.au with the Subject: “Can I please get a copy of

Cleanup.exe”) which does a number of maintenance functions like copying, moving and deleting files and folders . This program can be configured to run

once PDF-eXPLODE has completed its processing from the Program Processing option on the Completed Processing Notification screen.

Trial and Purchase

How Is PDF-eXPLODE Licensed?

See How Licensing Works.

Can I Get a Trial Copy of PDF-eXPLODE?

Yes. You can download a 45-day free trial version.

How Can I Buy PDF-eXPLODE?

After downloading and installing the 45-day trial version of PDF-eXPLODE, you can purchase a license by running the program and selecting Purchase this

software online and clicking Continue to order through our secure website.
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What's New in Version 2
This topic present the new feature of PDF-eXPLODE Version 2 to users already familiar with the features in Version 1.  Below is a summary of the new

features with links to the help topics that describe each feature in more depth.

Windows Vista and Terminal Server

• PDF-eXPLODE Version 2 is designed to work with Windows Vista, in addition to continuing support for Windows XP, Windows 2000 and Windows

2003.
• PDF-eXPLODE Version 2 is designed to work with Windows Terminal Server and Citrix Server.  You will need a PDF-eXPLODE Version 2 License for

each PDF-eXPLODE  user (refer to Network Licensing). You no longer need to leave the server logged in on the Administrator account.

Variables

Variables can be included in <pdfexplode> tags to:

• pass mail-merge fields into e-mail subjects and messages, for example to personalize a message with the recipient's name.
• name the exploded PDF files, for example embed an invoice number into a PDF file name for easier identification.
• name the folders in which PDF files are saved, for example use customer names to name the folders in which their PDF documents are archived.
• supply a user-specific password to secure each PDF file.
• provide the sender's e-mail address.

Quick Mail

Quick Mail enables you to create a PDF file and send it as an e-mail attachment without placing a PDF-eXPLODE tag in the document.  This is handy for ad-

hoc and one-off documents. 

E-mail Options

• You may use e-mail servers that require an encrypted connection using SSL or TSL encryption, such as Gmail.
• You may optionally format e-mail addresses to be sent through a fax server or to display the recipient's full name by selecting a default format in

General Settings.

New e-mail options may be specified and applied selectively to e-mails

• Read Notification is defined in General Settings and applied to a specific Default Message ID Tag, Client Details or a Client-specific Message ID Tag.
• Importance and Sensitivity flags are defined in General Settings  and applied to a specific Default Message ID Tag, Client Details or a Client-

specific Message ID Tag.
• Sender E-mail as defined in Mail Settings can be overridden on a specific Default Message ID Tag, Client Details or a Client-specific Message ID Tag.
• BCC e-mail addresses may now be defined for a Default Message ID Tag, Client Details or a Client-specific Message ID Tag.
• Delay each E-mail by a specified number of seconds to avoid errors that may occur on some e-mail (SMTP) servers.

Print

You can now designate whether to print a PDF on each Default Message ID Tag, Client Details or a Client-specific Message ID Tag.

• Print Only might be used to print PDF files for only those clients that do not have an e-mail address.
• Print Also might be used to keep a hard copy of each PDF that is e-mailed.

Distribution Lists

You can now send an e-mail to multiple recipients using a single <pdfexplode> tag in one of two ways:

• PDF-eXPLODE Tags may now include multiple e-mail addresses separated by comma (,).
• Client Details may now be named with either an e-mail address or any other desired identifier, for example the term "Managers" could be used and

then the e-mail addresses of several managers could be entered into the CC field to ensure all managers receive the same PDF document.

Other Conveniences

• Global PDF Password: You may now secure all documents using the same password.
• Optional Timestamp: You may now include or exclude a timestamp on exploded and/or e-mail attachment PDF filenames. A timestamp may be useful

when storing multiple versions of a document or it may be undesirable when sending and e-mail attachment.
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• PDF File Backup and Viewing: You may now choose whether to keep backup copies of PDF files when newer versions are created. You may not want

to keep backup files if you need to preserve disk space or want to prevent clutter. You can also view and print a PDF from within PDF-eXPLODE.
• Very Silent Mode: A new option allows you to suppress the dialogs displayed when using PDF-eXPLODE in silent mode. If you are running a large

batch this will enable you to continue work in other applications without interference from the popup status dialogs.
• Job Completed Notification: You may request an e-mail alert whenever a job is completed. You may also run a batch process or executable file at the

end of processing.
• Command Line Operation: The PDF-eXPLODE print queue window now closes after exploding a PDF when running PDF-eXPLODE from a command

line.
• Cancel Document: You may now cancel documents waiting in the PDF-eXPLODE printer queue.



 

 

 
What's New in Version 3
This topic present the new feature of PDF-eXPLODE Version 3 to users already familiar with the features in Versions 1 and 2.  Below is a summary of the new

features with links to the help topics that describe each feature in more depth.

Server Editions Now Available

Multiple users may share a single instance of PDF-eXPLODE on a PDF-eXPLODE server. Three different server configurations are supported - a different license

is available for each configuration:

• PDF-eXPLODE Terminal Server: Licensed per concurrent user, this edition works on a Microsoft Terminal Servicer or a Citrix Server product.
• PDF-eXPLODE Printer Server: Licensed per concurrent user, this edition works on any computer with PDF-eXPLODE configured as a shared printer.
• PDF-eXPLODE Report Server: Licensed per server, this edition works on BusinessObjects Enterprise, Crystal Reports Server, SQL Server Reporting

Services (SSRS) and other servers that run a report scheduler service.

HTML Format E-mail Messages

• E-mail messages can be formatted using HTML, providing the ability to use fonts and styles, colors, headings, paragraphs, bulleted and number lists,

hyperlinks and images. A built-in HTML editor is provided or you may use another HTML editor.

Send E-mail Using Outlook (MAPI)

• E-mail may be sent through Microsoft Outlook (i.e. a MAPI client), rather than sending through an SMTP server.

PDF-eXPLODE Tag Enhancements

• You can now include CC and BCC e-mail addresses within the <pdfexplode></pdfexplode> tag.

Variables Enhancements

• You can now use a variable to provide the e-mail From address. 
• The number of variables supported has been expanded to six to allow for the From address.
• You may now include commas within variable values such as in company names (e.g. United Data Strategies, Inc.) or in numbers (e.g. $1,234).

Cover Sheet Enhancements

• A cover sheet may now be inserted either at the beginning or the end of the exploded PDF, or as a second attachment to an e-mail.
• A cover sheet may now be specified on a specific Default Message ID Tag, Client Details or a Client-specific Message ID Tag.
• Quick Mail now allows you to attach another PDF document, such as a cover sheet.

Fax Server Support

• A new E-mail Address Format option allows you to control the format of the e-mail addresses you are sending to, which is useful for sending e-mails

to a fax server.

New Utilities

• A new Completed Processing Notification option allows you to specify a process to be executed at the end of processing, such as a .BAT or .EXE. You

can use this feature to copy, move or delete PDF files and more.
• A new PDF Combiner utility enables you to combine multiple master PDF files that may then be exploded to send multiple reports to a recipient in a

single PDF attachment.
• A new PDF Viewer utility is included.

Other Conveniences

• PDF-eXPLODE Options have a new user interface making it easier to navigate.
• A new item on the Printer Menu, Cancel, makes it easier to cancel a document that is being processed.
• Changes in the PDF-eXPLODE architecture improve its ability to withstand antivirus software attempts to disable/remove PDF-eXPLODE program

components.
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• Changes in the PDF-eXPLODE architecture improve support for larger and more complex documents.



 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

Installing



 

 

System Requirements

• Operating System: Microsoft® Windows® XP, Windows 2000, Windows Server® 2003, Windows Server® 2008, Windows Vista® or Windows 7
• Hard Drive: Minimum 52.5MB of free disk space, plus additional space for PDF files created
• RAM: At least 64MB of available memory, more during PDF creation. The size of the PDF that can be created is limited by the amount of available

memory.

 



 

 

 
Install PDF-eXPLODE

Log on to Windows

• If you are installing PDF-eXPLODE on a server you must be logged on at the console as the administrator.

 
- or -

 
• If you are installing PDF-eXPLODE on a workstation or stand-alone PC, we recommend that you log on as the administrator however it is not a

requirement.

Download PDF-eXPLODE

• Click the link on the website to download the PDF-eXPLODE setup program, PDF-eXPLODE Setup.exe.
• Click Save when you are asked “Do you want to run or save this file?”
• Select a folder on your hard drive in which to save the setup file.

Run the Setup Program

• When the download is complete, click Run.
• If you receive a security warning stating that the publisher could not be verified, click Run.
• When you see the Setup Wizard Welcome screen, click Next.

License Agreement

• Read the License Agreement, select I accept the agreement and click Next.

Select Destination Location

• Select the folder in which you want PDF-eXPLODE program files installed and click Next.

Select Components

• Click Next for Full Installation.

Select Start Menu Folder

You may select where to create the PDF-eXPLODE program shortcuts.

• If you want to create the shortcuts in the Start Menu PDF-eXPLODE folder, click the Next button.
• If you want to select a different folder, click the Browse button and find the folder you want, or type the full pathname of the folder you want, and

then click the Next button.

Select Additional Tasks

• Select Create a desktop icon to be able to launch PDF-eXPLODE from your desktop using a Windows shortcut.
• If you select to create a desktop icon, select whether you want the desktop icon For all users or For the current user only.

• Select whether to Create a Quick Launch icon.  Selecting this option adds a shortcut  icon for PDF-eXPLODE to the Quick Launch portion

of the taskbar located next to the Start button. If the Quick Launch bar is not displayed, right-click an empty area on the taskbar, point to

Toolbars, and then click Quick Launch.
• If you right-click an empty area on the taskbar and do not see the Toolbars option, click Lock the Taskbar to clear the check mark.

• Select whether to Create an entry in the Windows Explorer context menu. Selecting this option enables you to right-click a file, such as a

Word document, and create a PDF file using PDF-eXPLODE.

Ready to Install

• Review your settings.
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• Click Install to proceed or click Back to make any changes.

Completing the PDF-eXPLODE Setup Wizard

To complete the installation, you may be asked to restart your computer.

• Select Yes, restart the computer now or No, I will restart the computer later if you are not ready to restart and begin using PDF-eXPLODE.
• Click Finish.

Getting Started

• To begin using PDF-eXPLODE, please review the help topic Getting Started.
• If you installed PDF-eXPLODE on a network shared computer, for example to use with Terminal Services, Citrix, Business Objects Enterprise, Crystal

Reports Server, SQL Server Reporting Services or as a network shared printer, there are special considerations and configuration settings discussed in

the topic on Multi-user Administration.
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Multi-user Administration
PDF-eXPLODE may be installed on a network shared computer that is used as a terminal server, printer server or report server. However, please be aware that

a PDF-eXPLODE server license is required. Refer to How Licensing Works for more information.

• Example terminal servers: Microsoft Terminal Services, a Citrix Server product
• Example printer server: any computer with PDF-eXPLODE configured as a shared printer
• Example report servers: BusinessObjects, Crystal Reports Server, SQL Server Reporting Services (SSRS)

Installation

• Install PDF-eXPLODE at the computer's physical console — Do not install via a remote session.
• Log on to Windows using the Administrator account — Do not log on using a User account with "administrator privileges".

Server Configurations

PDF-eXPLODE Terminal Server

You may configure PDF-eXPLODE in one of two ways: Each user can have their own settings (the default) or all users can share the same settings.

• To configure PDF-eXPLODE so that all users share the same settings, navigate to the REG folder under the PDF-eXPLODE program folder

(default is C:\Program Files\PDF-eXPLODE) open the file named TurnAdminIni_ON.reg. Click OK when prompted. This will direct PDF-

eXPLODE to use the settings for the Administrator user account.
• To configure PDF-eXPLODE so that each user has their own settings, navigate to the REG folder under the PDF-eXPLODE program folder

(default is C:\Program Files\PDF-eXPLODE) open the file named TurnAdminIni_OFF.reg. Click OK when prompted. This will direct PDF-

eXPLODE to use the settings for the logged-in user account. This is the default setting after installation.

PDF-eXPLODE Printer Server

• During installation, PDF-eXPLODE is configured to store settings under the Windows Administrator user account (This is equivalent to

manually executing the file TurnAdminIni_ON.reg located in the REG folder in the PDF-eXPLODE program folder.)
• During installation, PDF-eXPLODE is configured to select Very Silent mode in General Settings to prevent dialogs that require user interaction

from displaying on the server console.
•  In the Windows Printers & Faxes folder, right-click PDFeXPLODE, select Sharing..., enable Share this printer, and enter Share name:

PDFeXPLODE.
• On each workstation that requires access to PDF-eXPLODE Printer Server, open the Windows Printers & Faxes folder and add the shared PDF-

eXPLODE printer.
• To evaluate PDF-eXPLODE Printer Server with a trial license, log on to the server using the Administrator account. After you print from a

workstation, the Evaluation dialog will display on the server. Select Evaluate this software and click Continue to proceed. This step is not

required when you have a paid license.

PDF-eXPLODE Report Server

• During installation, PDF-eXPLODE is configured to store settings under the Windows System user account (This is equivalent to manually

executing the files TurnAdminIni_ON.reg and TurnSystemIni_ON.reg located in the REG folder in the PDF-eXPLODE program folder.)
• During installation, PDF-eXPLODE is configured to select Very Silent mode in General Settings to prevent dialogs that require user interaction

from displaying on the server console.
• To evaluate PDF-eXPLODE Printer Server with a trial license, log on to the server using the Administrator account. After a scheduled report

is printed, the Evaluation dialog will display on the server. Select Evaluate this software and click Continue to proceed. This step is not

required when you have a paid license.  

Using the Trial License for Evaluation

• If you are using the Trial License, please be sure to close PDF-eXPLODE after changing or viewing settings.
• If you have set Administrator account settings ON, you must be at the server console to respond to the Evaluation dialog that appears each time you

print to PDF-eXPLODE.
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What's Installed Where
When you install PDF-eXPLODE, the following files and folders are created on your system.  If you remove PDF-eXPLODE, you may optionally keep your

settings (PDFeXPLODE.ini).

Note: You may wish to periodically delete old files in the C:\Program Files\PDF-eXPLODE\LOGS and C:\Program Files\PDF-eXPLODE\PDFs folders to make

more disk space available.

Folder Files installed

C:\Program Files\PDF-eXPLODE 1 Program, license file, properties and uninstall information (PDF-eXPLODE.exe, PDF-eXPLODE.lf,

pdfexplode.properties, UninstPDFeXPLODE.exe, unins000.exe and unins000.dat)

C:\WINDOWS\system32 Application Extension and ActiveX control files required by PDF-eXPLODE

C:\Program Files\PDF-eXPLODE\FAILED Folder will contain PDF files that failed to be sent by e-mail

C:\Program Files\PDF-eXPLODE\Help Help file (PDF-eXPLODE.chm)

C:\Program Files\PDF-eXPLODE\Icons Various icons used in the program group

C:\Program Files\PDF-eXPLODE\LOGS Program log file (PDF-eXPLODE.log).  Folder will also contain individual log files for each attempted e-

mail.

C:\Program Files\PDF-eXPLODE\PDFs Folder created to contain PDF files generated by PDF-eXPLODE.  (PDF files may also be saved in other

folders as specified by the user.)

C:\Documents and Settings\Owner\Application Data

\PDFeXPLODE 2
Program configuration file (PDFeXPLODE.ini) used to store user-specified options

1 This is the default program folder. You may change the default program folder at the time of installation.
2 This is the Application Data folder for the current user, which in this example is "Owner".  It may be hidden depending on your system settings.



 

 

Remove PDF-eXPLODE
You may need to remove PDF-eXPLODE from your computer. Note: If you are running a 30-day trial version and you remove and re-install PDF-eXPLODE, the

30-day trial period will not reset.

Removing PDF-eXPLODE

From the Start Menu

1. Click Start.
2. Point to Programs.
3. Point to the PDF-eXPLODE program group.
4. Click the Uninstall PDF-eXPLODE icon.

From the Control Panel

1. Click Start.
2. Point to Settings.
3. Point to Control Panel.
4. Click the Add or remove programs
5. Scroll the list down until the PDF-eXPLODE icon is visible.
6. Click the PDF-eXPLODE icon.
7. Click Change/Remove.
8. Click Yes to confirm the program will be removed.
9. Select whether to delete all program settings (i.e. the PDF-eXPLODE.ini file).
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Purchasing & Registering



 

 

Trial Version
The PDF-eXPLODE trial version allows you to evaluate the product and all of its capabilities for a period of 45 days from the date on which you install it.  The

trial version is the same software as the fully-licensed product with the following limitations:

• Only the first 25 PDF files that are exploded will be e-mailed and archived.
• E-mail messages will include promotional copy in the message footer with a link to the PDF-eXPLODE website.
• Archived PDF files will contain a cover page indicating that the file was created with an unlicensed copy of PDF-eXPLODE.
• The trial version cannot be used after 45 days following installation of the software.

To remove the trial version limitations and have a full-licensed, fully-functional product, purchase and register a license at any time during or after the 45-day

trial period.  You will receive a license id and password that must be activated over the Internet and will remove the trial version limitations - there is no need

to uninstall or re-install the software.



 

 

Purchase Online
When you open the Trial Version of PDF-eXPLODE, either during or after the 45-day trial period, you may purchase a full product license to remove the Trial

Version limitations.  Licenses are purchased over the internet using a credit card for payment.  A license ID and password will be provided immediately after

payment is authorized and will be confirmed in an e-mail automatically sent to the e-mail address you provide.

1. To begin, start PDF-eXPLODE.
2. In the PDF-eXPLODE Evaluation dialog box, select Purchase this software online and then click Continue.

 

 
3. Click Yes when prompted Display order form?

 

 
4. Click OK when prompted About to display order form

 

 
5. The Order Process form will appear in an Internet browser window.  Complete the online forms and print the completed order invoice, which

contains your License ID and Password.
6. Now select Activate online License ID and click Continue.
7. The Unlock via Internet dialog box will appear in a separate window.  At the end of the order process you were supplied with a License ID

and Password.

 



 

 

 
8. Enter your License ID and Password in the Unlock via Internet dialog box and then click OK.



 

 

Register Online
When you purchase PDF-eXPLODE online, you can activate the license at the same time after completing the order process.  However, it is not necessary to

register at the time you purchase - you may do so at any time thereafter by following the steps below.  Registering your product will remove the Trial Version

limitations.

After purchasing online, a license ID and password were provided in an invoice for you to have printed and were confirmed in an e-mail automatically sent to

the e-mail address you provide.  You will need these to register.

1. To begin, start PDF-eXPLODE.
2. In the PDF-eXPLODE Evaluation dialog box, select Activate online License ID and then click Continue.

 

 
3. Enter your License ID and Password in the Unlock via Internet dialog box and then click OK.

 

 



 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

Getting Started Tutorials



 

 

 
Create a PDF File
The purpose of this help topic is to show how to create your first PDF file using PDF-eXPLODE. PDF-eXPLODE is a valuable tool for automatically separating a

large document into individual sections and sending them as e-mail attachments to different recipients.  However, PDF-eXPLODE can also be used simply to

save a document in a PDF file as follows.

The following instructions assume you have just installed PDF-eXPLODE and have not yet changed the default configuration settings. Please note the default

paper size supported by PDF-eXPLODE is Letter. If your paper size is different, for example A4, you must edit the PDF File Creation Properties and set the

appropriate Paper Size before proceeding.

Create a PDF File

1. Open an existing document in an application such as Microsoft Word.
2. On the File menu, click Print.
3. In the Print dialog box, select the printer named PDF-eXPLODE and click OK.
4. When PDF-eXPLODE displays the Print Options dialog, click Create PDF.
5. In the Save as dialog box, select a folder, enter a file name and click Save.

View a PDF File

You may view the PDF file you just created if you have a PDF viewer installed such as the free Adobe Reader, available at www.adobe.com. If you do not have

a PDF viewer installed, PDF-eXPLODE includes one named Foxit Reader, which can be accessed from the Logging and Utilities screen.

1. Click Start, point to Programs, point to Accessories, and then click Windows Explorer.

 
-or-

 
Right-click Start and click Explore.

2. Select the folder in which you saved your PDF file.
3. Double-click the PDF file you created to open it.
4. Close the PDF when you are done viewing it. (If you leave it open and try to create it again you will get an error because the file is still in use

and cannot be overwritten.)
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Explode a PDF File
At the heart of PDF-eXPLODE is the ability to explode, or separate, a PDF file into individual PDF files.  This enables you, for example, to select and combine

different portions of a document into a resulting PDF file, or to e-mail different people different sections of a document.

The following instructions assume you have just installed PDF-eXPLODE and have not yet changed the default configuration settings.

Specify the Exploded PDF Filename

1. Open an existing document in an application such as Microsoft Word.  Make sure the document contains multiple pages.
2. At the top of page 1, type the following PDF-eXPLODE Tag, where "page1_" is the filename prefix of the PDF file that will contain the contents

of page 1.

 
<pdfexplode>page1_</pdfexplode>

3. In the page header, type the following PDF-eXPLODE tag, where "mydocument_" is the filename prefix of the PDF file that will contain the

contents of page 1.

 
<pdfexplode>mydocument_</pdfexplode> Tips

• Only pages that begin with a PDF-eXPLODE tag will be included in the PDF file attached to the e-mail, so the page header is the ideal location

to ensure each page is included.
• To type text in the page header of a Microsoft Word document, on the View menu click Header and Footer.  After typing the text, click

anywhere outside the header.
• The case of the open <pdfexplode> tag and the close </pdfexplode> tag must match, so always use lowercase to be safe.
• A tag must fit entirely on a single line.  Apply a small font size to minimize the risk of a tag not fitting entirely on a single line.
• The entire tag must have a standard Windows font applied to it, such as Arial or Times New Roman.
• You may change the color of the tag to white to make it invisible in the resulting document.
• You may include multiple PDF-eXPLODE tags per page if you want to include a page in multiple exploded documents.
• All of the pages associated with the same filename will be combined into a single PDF file.

Create and Explode the Document

PDF-eXPLODE can create and explode a PDF. However, if you have an existing PDF created by another process, you can still use PDF-eXPLODE to explode it -

refer to the instructions for using PDF-eXPLODE from a Command Line.

1. On the File menu, click Print.
2. In the Print dialog box, select the printer named PDF-eXPLODE and click OK.
3. When PDF-eXPLODE displays the Print Options dialog, click Explode Now.
4. In the Save as dialog box, select a folder, accept the default filename or enter a different file name and click Save.  (This is the "Master" PDF

file that contains the entire document.  Any existing version is overwritten without warning each time you re-create it.)
5. Click OK when prompted that PDF-eXPLODE successfully exploded the file.

View the Resulting PDF Files

You may view the PDF file you just saved if you have a PDF viewer such as the free Adobe Reader, available at www.adobe.com.

1. Click Start, point to Programs, point to Accessories, and then click Windows Explorer.

 
-or-

 
Right-click Start and click Explore.

2. Select the folder in which you saved your PDF file.
3. Double-click the Master PDF file you created to open it.  (This is the file created in step 4 above, which defaults to the name

PDFeXPLODE.PDF.)  Close your PDF viewer when done.
4. View your exploded PDF files in the same manner.  The file containing all of the pages in the document will be named "mydocument_*.pdf"

where the "*" is the date and time the file was created.  This feature helps in archiving different versions of, say, an account statement that is

sent monthly.  The other file, containing only the first page of your document will be named "page1_*.pdf".
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E-mail a PDF File
Although PDF-eXPLODE can explode a document or report into separate PDF files without sending them by e-mail, most users will want to take advantage of

the ability to send e-mail attachments.

The following instructions assume you have just installed PDF-eXPLODE and have not yet changed the default configuration settings.

Configure E-mail Settings

To e-mail a PDF file using PDF-eXPLODE, you first need to configure your e-mail settings. Follow the instructions on the Mail Settings topic.

Specify the E-mail Recipient

1. Open an existing document in an application such as Microsoft Word.
2. In the page header, type the following PDF-eXPLODE Tag, replacing "me@somewhere.com " with your actual e-mail address.

 
<pdfexplode>me@somewhere.com</pdfexplode> Tips

• Only pages that begin with a PDF-eXPLODE tag will be included in the PDF file attached to the e-mail, so the page header is the ideal location

to ensure each page is included.
• To type text in the page header of a Microsoft Word document, on the View menu click Header and Footer.  After typing the text, click

anywhere outside the header.
• The case of the open <pdfexplode> tag and the close </pdfexplode> tag must match, so always use lowercase to be safe.
• A tag must fit entirely on a single line.  Apply a small font size to minimize the risk of a tag not fitting entirely on a single line.
• The entire tag must have a standard Windows font applied to it, such as Arial or Times New Roman.
• You may change the color of the tag to white to make it invisible in the resulting document.
• You may include multiple PDF-eXPLODE tags per page if you want to send a page to multiple recipients.
• All of the pages associated with the same e-mail address will be combined into a single PDF file.

Create, Explode and E-mail the Document

PDF-eXPLODE can create and explode a PDF. However, if you have an existing PDF created by another process, you can still use PDF-eXPLODE to explode and

e-mail it - refer to the instructions for using PDF-eXPLODE from a Command Line.

1. On the File menu, click Print.
2. In the Print dialog box, select the printer named PDF-eXPLODE and click OK.
3. When PDF-eXPLODE displays the Print Options dialog, click Options.
4. In the Options dialog box, under PDF-eXPLODE Settings, select Send by email to all email addresses from the document tags, and

then click Save.
5. In the Print Options dialog, click Explode Now.
6. In the Save as dialog box, select a folder, enter a file name and click Save.
7. Click OK when prompted that PDF-eXPLODE successfully exploded the file.

View the Resulting E-mail

You may view the PDF file you just e-mailed yourself if you have a PDF viewer such as the free Adobe Reader, available at www.adobe.com. 

1. In your e-mail inbox, locate the e-mail you just sent yourself.
2. Open the e-mail and then open the PDF attachment. Close your PDF viewer when done.

View the Resulting PDF File

You may view the archived copy of the PDF file you just sent if you have a PDF viewer such as the free Adobe Reader, available at www.adobe.com.

1. Click Start, point to Programs, point to Accessories, and then click Windows Explorer.

 
-or-

 
Right-click Start and click Explore.

2. Select the folder in which you saved your PDF file.
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3. Double-click the PDF file you created to open it.  (The filename will be your e-mail address followed by the date and time.)  Close your PDF

viewer when done.

View the PDF-eXPLODE Log File

It is a good idea to check the PDF-eXPLODE Log File to be sure no errors occurred sending the e-mails.

1. Click Start, point to Programs, point to PDF-eXPLODE, and then click PDF-eXPLODE.
2. On the Printer menu, click PDF-eXPLODE Options....
3. In the Options List, click PDF-eXPLODE Settings.
4. Click View Transaction Logs to display individual log files for each e-mail in an Explorer window.  The PDF file names have the word

"SUCCESS" or "FAILED" appended to provide a compact summary status view. Tips

 
• Open a file if the name ends in "FAILED" to see a descriptive error message.
• Click View Detailed Log to display a detailed log of PDF-eXPLODE operations if you need more information.
• The detailed log appears in chronological order of when events occur, so the most recent events appear at the

bottom.
• You can see all of the steps taken by PDF-eXPLODE and can note any errors encountered.
• Be sure also to check the e-mail inbox for the Sender Name you specified in PDF-eXPLODE Connection

Settings. Undeliverable e-mails may return error notification e-mails to this address.
5. On the Printer menu, click Exit to close PDF-eXPLODE.
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Automate the Process
As you begin to use PDF-eXPLODE on a routine basis, you may no longer want to interact with the Print Options dialog each time you use PDF-eXPLODE.  A

feature called Silent Mode enables you to automate the complete process of document creation, explosion and e-delivery.

Selecting Silent Mode

1. Click Start, point to Programs, point to PDF-eXPLODE, and then click PDF-eXPLODE.
2. On the Printer menu, click PDF-eXPLODE Options....
3. In the Options dialog box, under General Settings, select Explode/E-mail in Silent Mode.

 
Important: If you are using a PDF-eXPLODE Server product (Report Server, Printer Server or Terminal Server) you must also select Suppress

display of any processing dialogs in Silent Mode.
4. Click Save. On the Printer menu, click Exit to close PDF-EXPLODE.

Specify the E-mail Recipient

1. Open an existing document in an application such as Microsoft Word.
2. In the page header, type the following PDF-eXPLODE Tag, replacing "me@somewhere.com " with your actual e-mail address.

 
<pdfexplode>me@somewhere.com</pdfexplode> Tips

• Only pages that begin with a PDF-eXPLODE tag will be included in the PDF file attached to the e-mail, so the page header is the ideal location

to ensure each page is included.
• To type text in the page header of a Microsoft Word document, on the View menu click Header and Footer.  After typing the text, click

anywhere outside the header.
• The case of the open <pdfexplode> tag and the close </pdfexplode> tag must match, so always use lowercase to be safe.
• A tag must fit entirely on a single line.
• You may include multiple PDF-eXPLODE tags per page if you want to send a page to multiple recipients.
• All of the pages associated with the same e-mail address will be combined into a single PDF file.
• You may change the color of the tag to white to make it invisible in the resulting document.

Create, Explode and E-mail the Document

1. On the File menu, click Print.  PDF-eXPLODE creates a master PDF, explodes it into a separate PDF for each e-mail recipient and sends each as

an e-mail attachment.

View the Resulting E-mail

You may view the PDF file you just e-mailed yourself if you have a PDF viewer such as the free Adobe Reader, available at www.adobe.com. 

1. In your e-mail inbox, locate the e-mail you just sent yourself.
2. Open the e-mail and then open the PDF attachment. Close your PDF viewer when done.

View the PDF-eXPLODE Log File

It is a good idea to check the PDF-eXPLODE Log File to be sure no errors occurred sending the e-mails.

1. Click Start, point to Programs, point to PDF-eXPLODE, and then click PDF-eXPLODE.
2. On the Printer menu, click Show Log File.
3. View the log and click Close when finished. Tips

 
• The log appears in reverse order of when events occur, so the most recent event is listed first.
• You can see all of the steps taken by PDF-eXPLODE and can note any errors encountered.
• Be sure also to check the e-mail inbox for the Sender Name you specified in PDF-eXPLODE Connection

Settings. Undeliverable e-mails may return error notification e-mails to this address.
4. On the Printer menu, click Exit to close PDF-eXPLODE.
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Start PDF-eXPLODE
You may open PDF-eXPLODE from the Windows Start menu or, optionally, from the desktop icon, if you chose to create one during installation.  In addition,

you may open PDF-eXPLODE from the Printers and Faxes Window.

Starting PDF-eXPLODE

From the Start Menu

1. Click Start.
2. Point to Programs.
3. Point to the PDF-eXPLODE program group.
4. Click the PDF-eXPLODE icon.

From the Desktop

If you chose to create a Desktop Icon during installation:

1. Double-click the PDF-eXPLODE icon.

From the Printers and Faxes Window

1. Click Start.
2. Point to Settings.
3. Click Printers.
4. Right-click the PDF-eXPLODE icon.
5. Click Open.
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Main Menu
The PDF-eXPLODE program window displays the main menu and and the print queue. The main menu consists of a menu bar with the following menu items.

Printer Menu

• Click Suspend Printer to hold PDF-eXPLODE jobs in a queue until you are ready to proceed.  For example, if you have a report that takes a long

time to generate and you do not want to be connected to the Internet during report generation you can stop the printer, generate the report, then

connect to the Internet and restart the printer to explode and e-mail the report.

 
When Suspend Printer is selected, a check mark will appear next to the menu item.  Documents that you print while Stop Printer is selected are

held in the PDF-eXPLODE queue.  The queue appears below the main menu and displays information about documents waiting to be exploded and e-

mailed. 

 
Click Suspend Printer again to restart the printer and remove the check mark .  Any print jobs pending in the queue will be processed (exploded

and e-mailed).  When Suspend Printer is de-selected, processing continues.  If silent mode is selected on General Settings, the pending documents

are exploded and e-mailed immediately.  If silent mode is not selected then the Print Options dialog is displayed to allow the user to control

processing. Click Set As Default Printer to specify that PDF-eXPLODE is the default printer used when you click Print on the File menu of many

Windows-based programs.  A check mark will appear next to the PDF-eXPLODE printer icon in your PC's Printers and Faxes window.

Tip

• To open Printers and Faxes, click Start, click Control Panel, click Printers and Other Hardware, and then click Printers and Faxes.
• Click Cancel Document to remove the selected document(s) from the queue.
• Click PDF-eXPLODE Options... to display and/or modify options including General Settings, Security Settings and Mail Settings, as well as Default

Messages, Client Details and Client-specific Messages.
• Click Exit to close PDF-eXPLODE.  It will still remain active as a printer driver enabling you to create, explode and e-mail PDF files when you click

Print on the File menu of many Windows-based programs.

View Menu

• Click Status Bar to display the status bar at the bottom of the PDF-eXPLODE window.  When selected, a check mark will appear next to the menu

item.  Click Status Bar again to hide the status bar and remove the check mark.  The status bar displays a count of the number of documents in the

PDF-eXPLODE FAILED folder and in the queue.

Help Menu

• Click Help Topics to access PDF-eXPLODE help information.
• Click About PDF-eXPLODE to display license and system information.

Below the menu bar is a print queue showing any files that were printed to PDF-eXPLODE and are currently being processed. Refer to Suspend Printer on

the Printer Menu for more details.

 
The print queue may also be used a shortcut for printing documents to PDF-eXPLODE.  To do so, simply drag-and-drop a file from Windows Explorer onto the

PDF-eXPLODE print queue. Note that document types that store a printer name (e.g. Microsoft Word documents) must be saved with PDF-eXPLODE as the

named printer.
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Specifying Options



 

 

 
General Settings
General Settings let you choose how you want to create and deliver the PDF files created by PDF-eXPLODE, as well as some default document properties.

 

To begin, start PDF-eXPLODE.

Open General Settings

1. On the Printer menu, click PDF-eXPLODE Options....
2. In the Options List, click General Settings.

Mail Options

• Choose Do Not Send by email to clients after exploding to create PDF files but not send them by e-mail. This option might be used to generate

exploded PDF documents for archiving or for distribution via local area network.
• Choose Send by email to all email addresses from the document tags to “explode,” or split, the document (e.g., a report, a Word document or

a mail-merge document) into individual PDF documents and send each individual PDF document to clients for whom a tag appears in the document.

This option is selected as the default. Note: Tags that are not valid e-mail addresses will not be sent but the exploded PDF files will be created and

saved.
• Choose Send by email just to selected clients if their email address is in the document tags to “explode,” or split, the document (e.g., a

report, a Word document or a mail-merge document) into individual PDF documents and send only the individual PDF documents tagged with an e-

mail address that you have defined in Client Details.  This feature allows you to treat selected clients as special cases. Note: Tags that are not valid e-

mail addresses will not be sent but the exploded PDF files will be created and saved.
• Select Send e-mail message as HTML if you want to send e-mail messages in HTML format. If you do not select this option, e-mail messages will

be sent in plain text format. Note that you can override this setting for a specific e-mail message on a Default Message ID Tags screen, for a specific

client on a Client Details screen or for a client-specific e-mail message on a Client-specific Message ID Tags screen.

E-Mail Notification

• Choose None if you do not want to be notified by e-mail when a recipient reads an e-mail sent by PDF-eXPLODE.
• Choose Notify me on Read to receive an e-mail notification (called a "read receipt") when a recipient reads an e-mail sent by PDF-eXPLODE. Note

that not all e-mail servers support this option and also a recipient may optionally deny sending a read notification.

E-Mail Flags

Select e-mail flags to apply to every e-mail that is sent. You may enable/disable the default e-mail flags for a specific e-mail message on a Default Message ID

Tags screen, for a specific client on a Client Details screen or for a client-specific e-mail message on a Client-specific Message ID Tags screen. Note that some

e-mail clients, such as Outlook Express, do not display all of the e-mail flags.

• Set Importance to Normal, Low or High. Press the Delete key to clear the selection.
• Set Sensitivity to Normal, Personal , Private or Confidential. Press the Delete key to clear the selection.

Default PDF Properties

You may specify the following PDF creation options and PDF file properties, which apply to every PDF file created. Property fields including Title, Author and

Subject may be displayed when a PDF file is opened  in a viewer such as Adobe Reader.

• Explode/E-mail in Silent Mode: If you select this checkbox, the program will run in Silent Mode, meaning it will run unattended after you initiate

printing a document. This is the default option. If you have an application that can initiate printing from the Windows Scheduler, then this option will

enable you to e-mail documents when you are away from the computer.  If you prefer to manage the delivery process, uncheck the checkbox and

manually set options  in the Print Options dialog after you initiate printing a document. If you print a document containing no PDF-eXPLODE tags, the

Print Options dialog will display regardless of the Silent Mode setting (except on PDF-eXPLODE Printer Server and PDF-eXPLODE Report Server, since

dialogs cannot be displayed on the workstation.)

 

• Note: you must select this option (and Very Silent Mode - see below) when operating PDF-eXPLODE on a Printer Server or Report Server that is

running under the SYSTEM account since there is no user interface available for the SYSTEM account. Failure to do so will result in the application

appearing to be frozen.Suppress display of any processing dialogs in Silent Mode [Very Silent Mode]: If you have selected Explode/E-
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mail in Silent Mode and select this checkbox, then all dialog and message windows will be suppressed. This is helpful if you want to process files

with PDF-eXPLODE in the background while you work on other Windows applications.

 
Note: you must select this option when operating PDF-eXPLODE on a Printer Server or Report Server that is running under the SYSTEM account

since there is no user interface available for the SYSTEM account. Failure to do so will result in the application appearing to be frozen.
• Suppress Quick Mail when the document has no <pdfexplode> Tags: By default, PDF-eXPLODE will display the Print Options dialog if you

print a document with no <pdfexplode> tags. This allows you to use the Quick Mail feature. Select this option to suppress the Print Options dialog

from displaying when no <pdfexplode> tags are present in the document.

 
Note: you must select this option when operating PDF-eXPLODE on a Printer Server or Report Server that is running under the SYSTEM account

since there is no user interface available for the SYSTEM account.
• Default Document Title specifies the filename and title of the master PDF document. Tips

• If you want to specify a different master PDF document name for different documents, create a Default Message ID, for example Invoice, and use

Exploded File Name to specify the file name, for example MasterInvoices. Then insert a <pdfexplode> tag on every page of your document as

follows:

<pdfexplode>Invoice#</pdfexplode>
• Use the Default Message ID Exploded File Path to designate a folder in which to save the file.

• Default Author shows the name of the person who created the PDF document.
• Default Subject specifies the subject of the PDF document.
• Default Document Path selects the folder in which the master PDF document and the exploded PDF documents are saved. Before the individual

PDF documents are created, a master PDF document is created, so it can be “exploded,” or split, into individual PDF documents. The recommended

setting for this property is C:\Program Files\PDF-eXPLODE\PDFs, where C:\Program Files\PDF-eXPLODE is the name of the folder where the

program is installed. Click Browse to navigate to the desired folder. You may override the location of the exploded PDF documents for a specific e-

mail message on a Default Message ID Tags screen, for a specific client on a Client Details screen or for a client-specific e-mail message on a Client-

specific Message ID Tags screen.

Default Cover Sheet

• Cover Sheet specifies whether to insert an existing PDF file into each exploded PDF, and specifies the full pathname to the selected PDF.  The

selected PDF may be any number of pages. Use this feature for such applications as including a generic newsletter or promotion in every PDF file

created by PDF-eXPLODE.Select the checkbox to enable insertion of the coversheet, or de-select the checkbox to disable this feature.
• Select whether to position the Cover Sheet PDF in the Front or Back of the exploded PDF file or as a Separate attachment.
• Click Browse to navigate to the desired PDF file name.

Tips

• You may use this feature in combination with the cover sheets defined on a Default Message ID Tags screen, for a specific client on a Client Details

screen or for a client-specific e-mail message on a Client-specific Message ID Tags screen for cover sheets inserted in the Front or Back of the

exploded PDF files. Both cover sheets will be included.
• If you select to include both the Default Cover Sheet PDF as a Separate PDF attachment and also specify a Cover Sheet PDF as a Separate

attachment on a Default Message ID Tags screen, Client Details screen or a Client-specific Message ID Tags screen, the default cover sheet

attachment will not be included.

Note: If you select to include the Default Cover Sheet PDF as a Separate attachment PDF Security Settings will be ignored, i.e. the behavior will be

the same as when Security Mode is set to Do Not Secure any PDF document after exploding.

Default File/Email Options

• Date-Time Stamp options specify whether to append the date and time to PDF file names. Appending the date and time may be helpful in

organizing multiple versions of the same file.Suppress DATE_TIME on exploded filename: If you select this checkbox, the date and time will

not be appended to the names of the exploded PDF files (i.e. the archived versions). Note that this option does not affect the attachment PDF files

(i.e. the e-mailed versions).
• Suppress DATE_TIME on e-mail attachment file: If you select this checkbox, the date and time will not be appended to the names of the

attachment PDF files (i.e. the files attached to e-mails). Note that this option does not affect the exploded PDF files (i.e. the archived versions).
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• Add leading '_' character to DATE_TIME in File names: This option is only available if you select one of the above DATE_TIME options. If you

select this checkbox, the DATE_TIME appended to exploded file names and attachment file names will be preceded by an underscore (_) character.

• E-mail Address Format options allow you to control the format of the e-mail addresses you are sending to, which is useful for sending e-mails

to a fax server.Standard Format: This is the default selection and is the best choice for most users. It assumes the e-mail addresses in your

<pdfexplode> document tags are in the standard e-mail format such as <pdfexplode>nancy@pdf-explode.com</pdfexplode>.
• Fax Sending 1: This format can be used with fax servers that expect the e-mail address to be in a format like: 9780001234<pdf-

explode@myfaxserver.net>. The e-mail address in the <pdfexplode> tag should be formatted slightly differently as:

<pdfexplode>9780001234!pdf-explode@myfaxserver.net</pdfexplode>, where the fax number is followed by an exclamation point (!)

and the angle brackets are omitted in the tag.
• Fax Sending 2: This format can be used with fax servers that expect the e-mail address to be in a format like:

Fax=9780001234@myfaxserver.net. The e-mail address in the <pdfexplode> tag should be formatted slightly differently as:

<pdfexplode>Fax9780001234@myfaxserver.net</pdfexplode>, where the equal sign (=) is omitted; it will be inserted by PDF-eXPLODE

before sending.
• Full Name Format: This format can be used when you want the recipient's full name to appear in the TO address instead of their e-mail address.

For example, if you are sending an e-mail to  Mary Doe in Accounts Payable at pdf-explode.net, you may want the TO address to appear as

Mary Doe(Accounts Payable) instead of accounts@pdf-explode.net. The e-mail address in the <pdfexplode> tag should be formatted

as <pdfexplode>Mary Doe(Accounts Payable)!accounts@pdf-explode.net</pdfexplode>, where the TO name is followed by an

exclamation point (!) and the angle brackets are omitted in the tag. The e-mail will be sent to Mary Doe(Accounts Payable) <accounts@pdf-

explode.net>.



 

 

 
Completed Processing Notification
You may configure PDF-eXPLODE to take certain actions upon completion of a print job. You may choose to send an e-mail alert and/or run an external

process at the end of processing.

To begin, start PDF-eXPLODE.

Open Completed Processing Notification

1. On the Printer menu, click PDF-eXPLODE Options....
2. In the Options List, click Completed Processing Notification.

E-mail Notification

You may specify the recipient's e-mail address, the e-mail subject and e-mail message.

• Send a message at the end of a print run processing: Select this checkbox to enable e-mail alerts.
• To - allows you to enter one or more e-mail addresses separated by commas (,).
• Subject - contains the e-mail subject. You may insert variables within the subject to create a mail merge if you have selected Use variables in e-

mail on the Variable Settings screen.
• Message - contains the e-mail message. You may insert variables within the subject to create a mail merge if you have selected Use variables

in e-mail on the Variable Settings screen. You may also insert <<Date>> and <<Time>> where you want PDF-eXPLODE to fill-in the current

system date and/or time at the moment the e-mail is sent.

Tips for Using a Variable

• When using a variable in the Subject or Message, the value should be a constant, i.e. the variable should contain the same value for all tags

in the document since only the last instance is used. This capability is useful for inserting the name of the report, for example.

Program Processing

You may specify a process to be executed at the end of processing. You might use this feature to copy, move or delete PDF files. For more information on

obtaining a program to copy, move and delete files send an e-mail request to mail@3000ad.com.au.

• Execute a Batch file or Program at the end of the processing run: Select this checkbox to enable program processing.
• Select whether to execute the Batch file (.BAT) or Program (.EXE) Before or After the E-mail Notification.
• Enter the full pathname of the Program to Run or click Browse to select it.
• Enter any necessary Program Parameter, or if the parameter is a filename click Browse to select it.
• Click Test Program to ensure it works as desired.
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Logging and Utilities
Logging enables you to audit program operations, identify failed e-mails and diagnose unusual issues. Utilities provide capabilities to backup, view and

combine PDF files.

To begin, start PDF-eXPLODE.

Open Logging and Utilities

1. On the Printer menu, click PDF-eXPLODE Options....
2. In the Options List, click Logging and Utilities.

Log Maintenance

Log Program Operations: Select this checkbox to save a detailed log of the steps taken by PDF-eXPLODE including any error messages, a summary

transaction log noting the success or failure of each e-mail and any PDFs that failed to be sent. 

• Click View Detailed Log to display a detailed log of PDF-eXPLODE operations in a Notepad window.  The detailed log contains documents each step

taken in exploding and e-mailing a PDF so there will be many lines of information per e-mail.  Close the Notepad window when you have finished

viewing or editing the log file.  If you continue using PDF-eXPLODE with a log file window opened, changes will not be reflected - you will need to

click View Detailed Log  again to see any subsequent changes.

 
Note: On multi-user systems, for example a Printer Server, you may see multiple user accounts listed. Select the desired user account name and then

click View Detailed Log to view the log for a particular user. Tips

• The window may be sized and scrolled to facilitate viewing.
• The log is displayed in chronological order with the most recent operations appearing at the bottom.
• You may edit the log file as desired, for example, you may wish to delete older portions no longer needed or save an archive version and clear it

entirely.
• To copy text so you can paste it into another application, select the text, right-click the mouse and click Copy.
• For the locations of the PDFeXPLODE.log and PDFeXPLODE.ini files, refer to What's Installed Where.

• Click View Transaction Logs to display individual log files for each e-mail in an Explorer window.  The PDF file names have the word "SUCCESS" or

"FAILED" appended to provide a compact summary status view. Tips

• Open a file if the name ends in "FAILED" to see a descriptive error message.
• Click View Failed Mail PDFs to access PDFs that were not sent in an Explorer window.  This feature will facilitate manually resending PDF files that

failed to send. Tips

• You can manually resend a PDF using an e-mail client program such as Microsoft Outlook.
• Click Delete Log Entries to reduce the size of the detailed log file by deleting entries dated ON or BEFORE a selected date. You will be prompted to

enter the desired date, where the accepted date format will be displayed (it varies depending on your Windows Regional Options.) Tips

• The detailed log file can grow quite large over time. Deleting older entries periodically can improve performance when viewing the log file and save

disk space.
• You may wish to archive a copy of the detailed log file before deleting entries. You can copy the log file the same way you would copy any file using

Windows Explorer.
• For the name and location of the log file refer to What's Installed Where for details.

PDF File Backups

• Don't Create BKP (Master) and BAK (Exploded) Back-up Archive files: If you select this checkbox, backup copies of the master PDF and

exploded PDF files will not be created.
• Click Delete Backup Files to remove backup copies of PDF files dated ON or BEFORE a selected date. You will be prompted to enter the desired

date, where the accepted date format will be displayed (it varies depending on your Windows Regional Options.) You may enter the desired file path

where the files to be deleted are located, or click Browse to navigate to the desired file path. You may also select whether to delete _bak or _bkp

files. Files named *_bkp.pdf are backup copies of the master PDF and files named *_bak.pdf are copies of exploded PDF files. After making your

selections, click Process to delete the files and then click Close when done. Tips
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• Deleting older files periodically will save disk space.
• For the default location of PDF files refer to What's Installed Where for details.

• Auto Backup of Option File to: If you select this checkbox, the file containing program options will be copied to the specified location each time

changes are saved. The default backup location if none is specified is the same directory in which the program options file resides. For the name and

location of the program options file refer to What's Installed Where for details. You may enter the desired file path where you would like the backup

copy to be saved, or click Browse to navigate to the desired file path. Tips

• If you need to maintain the same settings in two different user accounts (e.g. Administrator and SYSTEM), use this feature to propagate the

changes to the other user account.

PDF Viewer

• Click Browse to select a PDF file to view.
• Click Open PDF to view the selected PDF.

PDF Combiner

Use this function to combine multiple unsecured PDF files into a single PDF, which can then be exploded by running PDF-eXPLODE from a Command Line,

or by printing to PDF-eXPLODE from the PDF Viewer. Using PDF-eXPLODE in this manner will enable you to combine multiple PDF reports and documents

into a single e-mail attachment. If you want to create several master PDF files without exploding them so that you can combine them and then explode the

combined PDF, disable Silent Mode and then print to PDF-eXPLODE and select Create PDF.

• Click Combine PDFs to select up to five unsecured PDF files to combine. Note: the PDF files cannot have security applied, i.e. you cannot have an

Owner or User password applied.
• Click the Browse buttons to select the full pathname to the PDF you want to create (the output file) and up to five PDF files you want to combine

(the input files).
• Click Combine PDFs to perform the operation.
• Click Close when you are finished.
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Variable Settings
Variables let you customize e-mail subjects and messages and allow you to generate PDF file names and path names at runtime. Variables give you more

control over the content of e-mail messages and help you better organize your PDF documents. If you are printing from a program that provides the ability to

perform calculations (such as Crystal Reports, SQL Server Reporting Services, R&R Report Writer, Microsoft Access and Microsoft Excel) you can use formulas

to compute the values of the variables.

For example, you might save a person's first name into a variable and begin an e-mail message "Dear <Var1>:" where "<Var1>" would be replaced with a

person's first name to produce "Dear John:".  You can also use variables in file and folder names, where you might want to save invoices in folders identified

by a customer's name, and have the file name be the invoice number, for example, "C:\Invoices\CompanyA\Invoice_12345.pdf".

PDF-eXPLODE allows for up to six variables. Variables are passed to PDF-eXPLODE by placing them into the PDF-eXPLODE tag inserted into your document. 

The format for including variables in the <pdfexplode> tag is as follows :

<pdfexplode>Var1,Var2,Var3,Var4,Var5,Var6%MessageID#ClientID</pdfexplode>

Variables may be omitted, for example, if you only want to pass variable 2 and variable 4, your tag would be in this format:

<pdfexplode>,Var2,,Var4%MessageID#ClientID</pdfexplode>

NOTE: Be careful that your variable values do not inadvertently contain commas because the comma is used to separate variables. For example, you might

include a customer name as Smith, John, which would be interpreted by PDF-eXPLODE as two variables; the first variable's value is Smith and the second

variable's value is John. A similar problem can occur with numbers when a comma is used as a thousands separator. For example, a customer account

number  1234 may be inadvertently formatted as 1,234, which would be interpreted by PDF-eXPLODE as two variables; the first variable's value is 1 and the

second variable's value is 234.

If you must include a comma within a variable value, you may enclose the value within accent grave characters, i.e. the backwards single quote character (`)

or ASCII character 96, which is usually located on the same key as the tilde (~) to the left of the numeral one (1) key on the keyboard. For example, `Smith,

John` or `1,234` are permissible values that will preserve the embedded commas.

To begin, start PDF-eXPLODE.

Open Variable Settings

1. On the Printer menu, click PDF-eXPLODE Options....
2. In the Options List, click Variable Settings.

File Names

To use a variable to specify the name of the exploded PDF file, make the following selections.

• Select Use variable for exploded file name to enable this feature.

• Choose where you want the variable to appear in the file name.Choose Leading to use the variable as a prefix to the default file name. For

example, if the exploded file name is "_Invoice" and the variable value is "9995" then the resulting file name will be "99995_Invoice.pdf".
• Choose Trailing to use the variable as a suffix to the default file name. For example, if the exploded file name is "Invoice_" and the variable value

is "9995" then the resulting file name will be "Invoice_9995.pdf".
• Choose Full name to use the variable as the complete file name. For example, if the exploded file name is "Invoice" and the variable value is

"9995" then the resulting file name will be "99995.pdf".

Tips

• Note that the default file name is the client id in the <pdfexplode> tag, but may be overridden using the Exploded File Name option on a Default

Message ID Tag screen, Client Details screen or a Client-specific Message ID Tag screen.
• Windows does not permit the following characters to be used in file names: < > : " / \ | ? *
• Period (.) may not be used as the first character in a file name.
• PDF-eXPLODE does not permit the following characters to be used in file names: # % @ ~
• Apply a small font to a <pdfexplode> tag that includes variables because the tag can grow very wide and it must fit on a single line. We

recommend using Times New Roman font in 6 point font size.
• Select the variable to use for the file name: allows you to choose the variable whose value will be used in the file name. Select Var1, Var2,

Var3, Var4, Var5 or Var6.

Sub-Folder Names
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A variable may be used to name the folder in which a PDF file is saved. The designated folder is a sub-folder to the Default Document Path specified on the

General Settings screen, or the file path override specified on a Default Message ID Tag screen, for a specific client on a Client Details screen or for a client-

specific e-mail message on a Client-specific Message ID Tag screen.

To use a variable to create a sub-folder in which to save the exploded PDF files:

• Select Use variable to create a sub-folder to enable this feature.
• Select the variable for sub-folder name: allows you to choose the variable whose value will be used as the complete sub-folder name. Select

Var1, Var2, Var3, Var4, Var5 or Var6. If you specify a relative pathname, the parent folder must exist at runtime - PDF-eXPLODE will not create it.

File Password

A variable may be used to supply a user password to secure a PDF. If used, a password variable will override any other password settings specified on Default

Message ID Tag, Client Details, Client-specific Message ID Tag or PDF Security Settings. Use PDF Security Settings to select desired permissions (for

example, Allow Printing). If Security Mode is set to Do not secure any PDF document after exploding then all permissions will be disallowed.

• Select Use variable as a PDF password to enable this feature.
• Select the variable to use as Password: allows you to choose the variable whose value will be used as the password. Select Var1, Var2, Var3,

Var4, Var5 or Var6.
• Enter the Owner Password. The owner password is required. It must be entered by a person who has opened a PDF and wants to gain access to,

and modify, the document security permissions.

Tips

• Use this feature when the password is stored in a database for securing confidential documents such as Payroll direct deposit advice.
• If you select this feature but do not include a password variable in a document tag, the resulting exploded PDF file will not have security

applied (even if you set Security Mode to Secure all PDF documents after exploding).

From Address

A variable may be used as the e-mail from (i.e. return) address. The designated e-mail address is an override to the default Sender Name specified on Mail

Settings or the Sender E-mail override specified on a Default Message ID Tag screen, for a specific client on a Client Details screen or for a client-specific e-

mail message on a Client-specific Message ID Tag screen.

• Select Use variable as the E-mail FROM/Return Address to enable this feature.
• Select the variable for FROM address: allows you to choose the variable whose value will be used as the complete e-mail FROM address. Select

Var1, Var2, Var3, Var4, Var5 or Var6.

• Note: The FROM address value passed in the variable must be in one of the following formats:An e-mail address, for example,

jsmith@smithcompany.com
• A sender name followed by exclamation point (!) followed by an e-mail address, for example, John Smith!jsmith@smithcompany.com

Select Variable Usage in E-mail Merge

You may opt to have PDF-eXPLODE perform a mail merge in the e-mail from address, subject and message using the variables from the PDF-eXPLODE tags in

the document being printed.

• Select Use variables in e-mail to enable this feature.  Place variable names within angle brackets in your e-mail subject or message where you

want their values to appear.  For example, if variable 1 contains an invoice number, type "Invoice #<Var1>" to produce something like "Invoice

#12345". An example is given on the program screen.
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PDF Security Settings
PDF Security Settings let you protect the PDF files you create with PDF-eXPLODE. PDF-eXPLODE can protect your PDF documents from unauthorized viewing,

copying, sharing, modifying or printing.

By default, all PDF documents created with PDF-eXPLODE do not have security enabled. Security may be applied:

• globally to all exploded PDF files by assigning the same password to every PDF file (see Specify Passwords below),
• globally to all exploded PDF files by assigning an individual password to each PDF using Variables in the PDFeXPLODE tag, which override the settings

on this screen,
• on an exception basis to exploded PDF files for specific recipients for whom you create a Client Details screen and select the option labeled Protect

Resulting PDF document.

PDF-eXPLODE lets you choose security settings for each security-enabled PDF document you create. While it is not necessary to secure your PDF documents,

you should consider the purpose for which a document will be used, the sensitivity of the contents and who will be receiving it.

Note: Security is not applied to Cover Sheets that are sent as a separate PDF attachment or to Quick Mail PDF files.

To control access to your PDF files, you enable encryption, select the permissions you wish to grant and apply passwords.

To begin, start PDF-eXPLODE.

Open PDF Security Settings

1. On the Printer menu, click PDF-eXPLODE Options....
2. In the Options List, click PDF Security Settings.

Set Security Mode

Set a security mode to specify whether and how to apply security to the PDF files created. If you opt to secure PDF files, then you must enter an Owner

Password (see below). Note that security applied using variables will override the settings on this screen.

• Do not secure any PDF document after exploding offers no security but should be compatible with all PDF viewing programs.
• Secure all PDF documents after exploding allows you to secure all documents using the same password, i.e. a global password. This option

provides convenience while sacrificing security, since all PDF files will have the same password as entered below. You may override the default

passwords specified below for specific documents and clients on a Client Details screen or a Client-specific Message ID Tags screen. Note: The use of

password variables in the <pdfexplode> tag takes precedence over these settings.
• Secure just the PDF documents for the selected clients after exploding allows for greater security by providing for different passwords to be

assigned to different PDF files. You may override the default passwords specified below for specific documents and clients on a Client Details screen

or a Client-specific Message ID Tags screen.

Set Encryption Level

Encryption allows you to control access to the PDF files generated by PDF-eXPLODE.  If you select to secure PDF files using Security Mode, specify whether

to use 40 bit or 128 bit encryption.

• 40 bit encryption provides some security but is compatible only with Adobe Acrobat or Reader v4 or below. We recommend not using this setting

unless you know you must. Selecting this option will allow you to specify some permissions.
• 128 bit encryption offers the greatest degree of security but is compatible only with Adobe Acrobat or Reader v5.0 or higher. Most users should have

v5.0 or higher, so this is the recommended setting for users wanting encryption security. Selecting this option will allow you to specify all available

permissions.

Set Permissions

Select the permissions you wish to apply to your PDF documents. Permissions for the document can be set separately from access to the document. For

instance, with Password Security, it's possible to require different passwords to open (a User Password) and manipulate (an Owner Password) the document,

meaning that you can allow one set of users to view the document, and another, smaller set to copy or print the document.

• Allow Printing - print the document (possibly not at the highest quality level, depending on whether allow-degraded-printing is also set).  To

disallow printing, de-select this permission and also the permission labeled Allow Degraded Printing.
• Allow Modify Contents - modify the contents of the document by operations other than those controlled by Allow Modify Annotations, allow Fill In

and Allow Assembly
• Allow Copy - copy or otherwise extract text and graphics from the document by operations other than that controlled by Allow Screen Readers
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• Allow Modify Annotations - add or modify text annotations, fill in interactive form fields and, if Allow Modify Contents is also set, create or modify

interactive form fields (including signature fields )
• Allow Fill In - fill in existing interactive form fields (including signature fields), even if Allow Modify Annotations is not set
• Allow Screen Readers - extract text and graphics (in support of accessibility to disabled users or for other purposes)
• Allow Assembly - assemble the document (insert, rotate or delete pages and create bookmarks or thumbnail images), even if Allow Modify

Contents is not set
• Allow Degraded Printing - when this is set (and allow-printing also is set), printing is limited to a low level representation of the appearance,

possibly of degraded quality.  To disallow printing, de-select this permission and also the permission labeled Allow Printing.

To view permission settings in resulting PDF documents, open a PDF generated by PDF-eXPLODE using Adobe Acrobat or Adobe Reader and select Document

Properties from the File menu.  Permission settings appear on the Security dialog window.

 

Specify Passwords

You can specify two passwords for PDF documents created by PDF-eXPLODE: a User Password and an Owner Password.  The "user" is the person to

whom you are sending a PDF and the "owner" is you.  You should specify different passwords for the User and Owner or else a user will have access to

change permissions.  You may override these general passwords with passwords specific to an e-mail message defined on a Default Message ID Tag screen,

which may be overridden by passwords specific to an e-mail recipient defined on a Client Details screen, which may be overridden by passwords for a client-

specific message on a Client-specific Message ID Tags screen.

SecuritySettings.htm#
SecuritySettings.htm#


 

 

• User Password if specified, must be entered by a user to open and view a PDF document generated with this password.    User Password must be

different than Owner Password to protect the document against users changing the document's permissions.
• Owner Password is required if Encryption Level is set to either 40 bit or 128 bit.  If specified, the owner password must be entered by a person

who has opened a PDF and wants to gain access to, and modify, the document security permissions.



 

 

 
Mail Settings
Mail Settings let you configure PDF-eXPLODE to communicate with your e-mail server and construct the default e-mail message.

 

To begin, start PDF-eXPLODE.

Open Mail Settings

1. On the Printer menu, click PDF-eXPLODE Options....
2. In the Options List, click Mail.

Default E-Mail Settings

The default e-mail Subject and Message appear when your e-mails are viewed by recipients.  You can change them each time you send e-mail using PDF-

eXPLODE, or you may override the default message for a specific e-mail message on a Default Message ID Tags screen, for a specific client on a Client Details

screen or for a client-specific e-mail message on a Client-specific Message ID Tags screen.

• Select Send e-mails as HTML to format e-mail messages using HTML. Using HTML enables you to format e-mail messages using fonts and images,

etc. If you do not select this option, e-mails will be sent as text (i.e. without formatting such as fonts, etc.) An HTML editor is provided with PDF-

eXPLODE, or you may use another editor and specify the file to be used.
• Subject: Enter an e-mail Subject. You may insert variables within the subject to create a mail merge if you have selected Use variables in e-mail

on the Variable Settings screen.
• Message File: If you selected Send e-mails as HTML, enter a full pathname to the file containing the HTML message. To browse to the file that

you want to select or create, clear the contents of Message File and click Edit HTML File (see below).
• Message Text: If you selected the Send e-mails as HTML option, the HTML file contents are displayed. If you did not select the Send e-mails as

HTML option, you may edit the message text here. You may insert variables within the message to create a mail merge if you have selected Use

variables in e-mail on the Variable Settings screen.
• If you are sending e-mails in HTML format, click Edit HTML File to use the PDF-eXPLODE HTML Editor to edit the HTML file specified in Message

File, or to create a new HTML file if the Message File option is blank. You may optionally use another HTML editor and specify the Message File

above.

E-Mail Connection Settings

You can send e-mail using either PDF-eXPLODE (an SMTP client) or through Microsoft Outlook (a MAPI client).

Use PDF-eXPLODE (SMTP)

To send e-mail using PDF-eXPLODE's SMTP client, you need to tell PDF-eXPLODE your Connection Settings as follows.  After supplying the necessary

information, click the Test Connection button to send a test e-mail to the Sender Name e-mail address and confirm the settings are correct and

working.

• Select Use PDF-eXPLODE (SMTP).
• The Sender Name can be whatever name you wish to appear in the From field as viewed by recipients of your e-mail.  Undeliverable e-

mails may return error notification e-mails to this address, which can be used to help clean your e-mail list and re-send important documents.

  Enter a name followed by an e-mail address within angle brackets, for example:

John Smith <jsmith@smithcompany.com>

The following information usually supplied to you by your organization's e-mail administrator or your Internet Service Provider (ISP):

1. Name of your Outgoing Mail SMTP Server.  This may be entered in one of three formats:DNS Name, for example:

smtp.mycompany.com
2. IP Address, for example: 192.168.10.25
3. Server Name: for example: smtp_srvr1

• Your Sign-on Username, if you use a web hosting service this will often be your e-mail address (for example: myname@mycompany.com),

whereas if your company has its own e-mail server you may only need to enter your login name (for example, myname).
• Your Sign-on Password.  (The password is not displayed and is encrypted before being saved by PDF-eXPLODE to protect your privacy.)
• The Authentication Type required by your e-mail server. Select; None, POP, Login or Plain.
• The Port number used by your e-mail server (usually 25)
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• Name of your Incoming Mail (POP3) Server (for example pop.mycompany.com).  This is only required when you have set

Authentication Type to POP3.
• Select Delay each E-Mail to set the time delay between sending each e-mail (after the first one is sent) to between 1 and 60 seconds. This

can help prevent errors such as 'Too Many Connections' from occurring when the SMTP (e-mail) server limits the number of e-mail that can

be sent simultaneously.
• Select SSL/TLS if your e-mail server requires an encrypted (i.e. a secure) connection, e.g. Gmail.
• Click Test Connection to test the e-mail settings and send a test e-mail to the Sender Name.

Use Microsoft Outlook (MAPI)

To send e-mail using Microsoft Outlook (a MAPI client) client, you only need to ensure Outlook is installed and configured properly. The following

options are available.

• Select Use Microsoft Outlook (MAPI).
• Select Send as a DRAFT to place the e-mail into the Outlook Drafts folder. A benefit of doing so is that the Outlook security will not ask for

manual confirmation. If you do not select this option, the e-mail will be placed into the Outbox folder, which requires clicking Yes in response

to an Outlook security warning dialog that asks you to confirm mail sending from third party applications.

 
Note: This means that PDF-eXPLODE Silent and Very Silent modes will stop processing until receiving a manual response. To maintain

continuity of the PDF-eXPLODE processing in silent (unattended) mode, it will be necessary to install a software utility like ClickYES, which

will automatically ‘click’ the Yes button and continue processing in your absence. There are free programs available on the Internet that will

automatically click Yes in response to the Outlook security warning dialog. Search for "click yes", or you may download ClickYES from http://

www.3000ad.com.au/ClickYesSetup.exe.
• Select Send FROM address as 'on behalf of' to specify the FROM e-mail address if you have permission to send messages on behalf of

another person. Enter the desired e-mail address in Sender Name <Sender E-mail Addr> (see below), or you may override the From

address for a specific e-mail message on a Default Message ID Tags screen, for a specific client on a Client Details screen or for a client-

specific e-mail message on a Client-specific Message ID Tags screen.

• The Sender Name <Sender E-mail Addr> is used in conjunction with Send FROM address as 'on behalf of' to specify the FROM e-

mail address if you have permission to send messages on behalf of another person. It can be whatever name and e-mail address you wish

to appear in the From field as viewed by recipients of your e-mail, provided you are permitted to send messages on behalf of that e-mail

address. Enter a name followed by an e-mail address within angle brackets, for example:

John Smith <jsmith@smithcompany.com>

Tips

• This is the From e-mail address not to be confused with the Reply-To e-mail address, which will be the default e-mail address specified in

your MAPI client (e.g. Microsoft Outlook) and is also the e-mail address to which undeliverable e-mails may return error notification e-mails.
• If you do not set Microsoft Outlook to Send immediately when connected, the e-mail(s) will not be sent and will remain in the Outbox

folder. You will need to move the e-mails to the Drafts folder and open and re-send them and then click Send/Receive.

Exploded File Details

Set the default name and folder for exploded PDF files. You may override these default settings for a specific e-mail message on a Default Message ID Tags

screen, for a specific client on a Client Details screen or for a client-specific e-mail message on a Client-specific Message ID Tags screen.

• Exploded File Name will replace the e-mail address in each exploded PDF file name with text of your choice. 

 
Example: The exploded PDF files created by PDF-eXPLODE are named according to the e-mail recipient and, optionally, the date and time of creation.

  For example, an e-mail sent to nancy@pdf-explode.com on May 28, 2007 at 1:23 PM will have an attachment PDF file named:

 
        nancy@pdf-explode.com070528_132300.pdf

 
If you enter Invoice in this field then the resulting attachment PDF filename will be:

 
        Invoice070528_132300.pdf 
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To remove the date and time from PDF filenames, use the options Don't add DATE_TIME to exploded filename and Don't add DATE_TIME

to e-mail attachment file, which are located on the General Settings screen.  Following the example above, these options enable you to set the e-

mailed and archived filenames to:

 
        Invoice.pdf  

• Exploded File Path allows you to select a folder where exploded PDF files will be saved (i.e. archived).  Type the desired pathname (e.g. C:

\Documents and Settings\Nancy\My Documents\Archived PDF-eXPLODE Files) or click Browse to locate and select the desired path without typing it.

 
 

Click Save to save your settings.

On the Printer menu, click Exit to close PDF-eXPLODE.



 

 

 
Default Message ID Tags
Default Message ID Tags allow you to specify whether a particular type of document should be printed, e-mailed or both.  If e-mail is selected, you may also

define the subject and message. For example, you could define a Default Message ID Tag "Invoice" to have a default e-mail subject and message applied to

all of the invoices you e-mail. In addition, you can specify the PDF file name, path name and security passwords.

You may override the default message settings by creating a Client-specific Message ID Tag with the same name.

To begin, start PDF-eXPLODE.

Open Default Message ID Tags

1. On the Printer menu, click PDF-eXPLODE Options....
2. In the Options List, click the plus sign (+) to the left of Mail Settings.
3. Click the plus sign (+) to the left of Default Message ID Tags.

Create a Default Message ID Tag

1. If there are no existing message ID tags, click New Message ID.

 
-or-

 
If there are existing message ID tags, click any existing message ID tag.

2. Click the button labeled New.
3. Complete the following fields: Message Details

• Message ID is the tag or name you use to identify this set of options in the PDF-eXPLODE tag inserted into your report or document. The

Message ID may not include any spaces.
• Select Apply E-Mail Notification to receive an e-mail notification (called a "read receipt") when a recipient reads an e-mail sent by PDF-

eXPLODE. You must also choose Notify me on Read on the General Settings screen for this option to take effect. Note that not all e-mail

servers support this option and also a recipient may optionally deny sending a read notification.
• Select Apply E-Mail Flags to set the Importance and Sensitivity flags specified on the General Settings screen. Note that some e-mail clients,

such as Outlook Express, do not display all of the e-mail flags.
• Select Send e-mails as HTML to format e-mail messages using HTML. Using HTML enables you to format e-mail messages using fonts and

images, etc. If you do not select this option, e-mails will be sent as text (i.e. without formatting such as fonts, etc.) An HTML editor is provided

with PDF-eXPLODE, or you may use another editor and specify the file to be used. The Message ID may not include any spaces.

• Choose Print if you want to print documents. Note: If security is applied to a PDF then printing will not occur. Only one copy may be

printed.Choose ONLY (don't E-Mail) to print documents with this message ID but not e-mail them.

 
-or-

 
Choose ALSO ( print and E-Mail) to print in addition to e-mailing the documents. 

• Select a printer from the dropdown list of available printers.

Tips

• Use Print Only in combination with Variables when you need to e-mail some documents and print others, based on whether you have the

recipient's e-mail address in your database. For example, you may be e-mailing invoices but need to print and mail hard-copy invoices to

customers who do not have an e-mail address. You could use a formula in your report to conditionally insert into the <pdfexplode> tag a

Message ID whose purpose is to Print Only for those customers without an e-mail address.  Customers with e-mail addresses would have a

different Message ID inserted into their <pdfexplode> tag whose purpose is to specify the e-mail subject and message.
• Use Print Also when you want to send documents by e-mail but also need to keep a hard-copy for your physical files.
• Do not use a message id like PRN, which results in PDF-eXPLODE trying to create a file with an invalid filename. The following device names

are reserved by Windows and cannot be used as a filename: CON, PRN, AUX, NUL, COM1, COM2, COM3, COM4, COM5, COM6, COM7, COM8,

COM9, LPT1, LPT2, LPT3, LPT4, LPT5, LPT6, LPT7, LPT8, and LPT9.

Specific E-mail Settings
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• Sender E-mail can be filled in if you want to override the default sender e-mail address specified on the Mail Settings screen.

  The Sender Name can be whatever name you wish to appear in the From field as viewed by recipients of your e-mail.

  Undeliverable e-mails may return error notification e-mails to this address, which can be used to help clean your e-mail list

and re-send important documents.  Enter a name followed by an e-mail address within angle brackets, for example:John Smith

<jsmith@smithcompany.com>

As an alternative to entering sender e-mail address here, a variable may be used to provide the sender e-mail address. For example, if the e-

mail address is contained in variable 3, enter <var3>.
• CC can be checked to send a copy of each e-mail to one or more e-mail recipients.  Multiple CC e-mail addresses must be separated with a

comma (,) or semicolon (;). Unlike BCC, recipients will see each other's e-mail addresses.
• BCC can be checked to send a blind copy of each e-mail to one or more e-mail recipients.  Multiple BCC e-mail addresses must be separated

with a comma (,) or semicolon (;). Unlike CC, BCC recipients will not see each other's e-mail address.
• Subject is the subject that appears on the e-mail when received by your clients. You may insert variables within the subject to create a mail

merge if you have selected Use variables in e-mail on the Variable Settings screen.
• Message File should contain a full pathname to the file containing the HTML message if you selected the Send e-mails as HTML option. If you

are sending e-mails in text format, leave this field blank. To browse to the file that you want to select, clear the contents of Message File and

click Edit HTML File (see below).
• Message is the message that will appear in the body of the e-mail received by your clients. You may insert variables within the message to

create a mail merge if you have selected Use variables in e-mail on the Variable Settings screen.
• If you are sending e-mails in text format, click Edit Text to enlarge the area for editing the message, and then click Update to save the

changes or Cancel to discard any changes.
• If you are sending e-mails in HTML format, click Edit HTML File to use the PDF-eXPLODE HTML Editor to edit the HTML file specified in

Message File, or to create a new HTML file if the Message File option is blank. You may optionally use another HTML editor and specify the

Message File above.

Exploded File Details

Set the default name and folder for exploded PDF files, and options for inserting a cover page. These settings override those specified on the

Mail Settings screen.

• Exploded File Name will replace the e-mail address in each exploded PDF file name with text of your choice. 

 
Example: The exploded PDF files created by PDF-eXPLODE are named according to the e-mail recipient and, optionally, the date and time of

creation.  For example, an e-mail sent to nancy@pdf-explode.com on January 28, 2009 at 1:23 PM will have an attachment PDF file named:

 
        nancy@pdf-explode.com090128_132300.pdf

 
If you enter Invoice in this field then the resulting attachment PDF filename will be:

 
        Invoice090128_132300.pdf 

 
After being e-mailed, the exploded PDF filename will be the same unless you select Suppress DATE_TIME on exploded filename, in which case

the filename will be:

 
        Invoice.pdf  

• Exploded File Path allows you to select a folder where exploded PDF files will be saved (i.e. archived).  Type the desired pathname (e.g. C:

\Documents and Settings\Nancy\My Documents\Archived PDF-eXPLODE Files) or click Browse to locate and select the desired path without

typing it.

• Cover Sheet specifies whether to insert an existing PDF file into each exploded PDF, and specifies the full pathname to the selected PDF. 

The selected PDF may be any number of pages. Use this feature for such applications as including a generic newsletter or promotion in every

PDF file created by PDF-eXPLODE. Note: This cover sheet is in addition to any cover sheet defined in General Settings.Select the checkbox to

enable insertion of the coversheet, or de-select the checkbox to disable this feature.
• Select whether to position the Cover Sheet PDF in the Front or Back of the exploded PDF file or to include it in an e-mail as a Separate

attachment.
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• Click Browse to navigate to the desired PDF file.

Tips

• You may use this feature in combination with the the Default Cover Sheet PDF defined in General Settings for cover sheets inserted in the

Front or Back of the exploded PDF files. Both cover sheets will be included.
• If you select to include both the Default Cover Sheet PDF as a Separate attachment and also specify a Cover Sheet PDF as a Separate

attachment on a Default Message ID Tags screen, Client Details screen or a Client-specific Message ID Tags screen, the default cover sheet

attachment will not be included.

Exploded PDF Security

• User Password is a general password for viewing documents sent with this message that is applied to all clients you have specified to receive

protected PDF files.  You may override this password for a specific client on a Client Details screen or on a Client-specific Message ID Tags

screen.  User Password must be different than Owner Password to protect the document against users changing the document's permissions.
• Owner Password is a general password for manipulating permissions in documents sent with this message that is applied to all clients you

have specified to receive protected PDF files.  You may override this password for a specific client on a Client Details screen or on a Client-

specific Message ID Tags screen.

 

1. Click Apply to save your changes and remain in PDF-eXPLODE Options.

 
-or-

 
Click Save to save your changes and exit PDF-eXPLODE Options.

 
-or-

 
Click a different option in the Options List on the left to discard changes and remain in PDF-eXPLODE Options.

 
-or-

 
Click Cancel to discard unsaved changes and exit PDF-eXPLODE Options.

Edit a Default Message ID Tag

• Click an existing message ID.Click Edit.
• Make your desired changes.
• Click Apply to save your changes and remain in PDF-eXPLODE Options.

 
-or-

 
Click Save to save your changes and exit PDF-eXPLODE Options.

 
-or-

 
Click Cancel to discard unsaved changes and exit PDF-eXPLODE Options.

Delete a Default Message ID Tag

• Click an existing message ID.Click Remove.
• Click Yes to confirm the deletion or No to cancel.

Rename a Default Message ID Tag

1. To rename a message ID you must delete it and re-create it.
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Client Details
Client Details allow you to specify file, print, security and e-mail settings for an individual Client or clients on an exception basis.  Clients for whom you do

not specify client details will default to the General Settings, or the Default Message ID Tag settings if you have defined them.  Also, clients for whom you do

not specify client details will not receive security-enabled (encrypted or password-protected) PDF files unless you select Secure all PDF documents after

exploding on the General Settings screen.  There are many possible uses for defining Client Details including:

• Use Client Details to send e-mails only to those clients for whom you have defined client details, if you select Send by email just to selected

clients if their email address is in the document tags on the General Settings and you select Send mail to this client if his email

address exists in the document tags in the client details.  This feature may be useful if you needed to produce a one-time e-mailing only to

selected clients.
• Use Client Details to specify file name and security settings to apply to archive files that are not to be e-mailed.
• Use Client Details to create an e-mail distribution list to send a document to a named group of people.  For example, you can associate the name

"Managers" with the e-mail addresses for a group of managers.
• Use Client Details to associate a client name with an e-mail address when the source application does not contain e-mail addresses, such as legacy

systems.

To begin, start PDF-eXPLODE.

Open Client Details

1. On the Printer menu, click PDF-eXPLODE Options....
2. In the Options List, click the plus sign (+) to the left of Mail Settings.
3. Click the plus sign (+) to the left of Clients.

Create a New Client

1. If there are no existing client details, click New Client.

 
-or-

 
If there are existing client details, click any existing client.

2. Click the button labeled New Client.
3. Complete the following fields: Client Details

• Client ID or E-mail Address is the e-mail address of the client, or a unique identifier such as the name of a distribution list or an archive file

name. The Client ID may not include any spaces.
• Select Apply E-Mail Notification to receive an e-mail notification (called a "read receipt") when a recipient reads an e-mail sent by PDF-

eXPLODE. You must also choose Notify me on Read on the General Settings screen for this option to take effect. Note that not all e-mail

servers support this option and also a recipient may optionally deny sending a read notification.
• Select Apply E-Mail Flags to set the Importance and Sensitivity flags specified on the General Settings screen. Note that some e-mail clients,

such as Outlook Express, do not display all of the e-mail flags.
• Select Send e-mails as HTML to format e-mail messages using HTML. Using HTML enables you to format e-mail messages using fonts and

images, etc. If you do not select this option, e-mails will be sent as text (i.e. without formatting such as fonts, etc.) An HTML editor is provided

with PDF-eXPLODE, or you may use another editor and specify the file to be used.

• Choose Print if you want to print documents. Note: If security is applied to a PDF then printing will not occur. Only one copy may be

printed.Choose ONLY (don't E-Mail) to print documents with this message ID but not e-mail them

 
-or-

 
Choose ALSO ( print and E-Mail) to print in addition to e-mailing the documents. 

• Select a printer from the dropdown list of available printers.
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• Do not use a client id like PRN, which results in PDF-eXPLODE trying to create a file with an invalid filename. The following device names are

reserved by Windows and cannot be used as a filename: CON, PRN, AUX, NUL, COM1, COM2, COM3, COM4, COM5, COM6, COM7, COM8,

COM9, LPT1, LPT2, LPT3, LPT4, LPT5, LPT6, LPT7, LPT8, and LPT9.

Specific E-mail Settings

• Sender E-mail can be filled in if you want to override the default sender e-mail address specified on the Mail Settings screen.

  The Sender Name can be whatever name you wish to appear in the From field as viewed by recipients of your e-mail.

  Undeliverable e-mails may return error notification e-mails to this address, which can be used to help clean your e-mail list

and re-send important documents.  Enter a name followed by an e-mail address within angle brackets, for example:John Smith

<jsmith@smithcompany.com>

As an alternative to entering sender e-mail address here, a variable may be used to provide the sender e-mail address. For example, if the e-

mail address is contained in variable 3, enter <var3>.
• CC can be checked to send a copy of each e-mail to one or more e-mail recipients.  Multiple CC e-mail addresses must be separated with a

comma (,) or semicolon (;). Unlike BCC, recipients will see each other's e-mail addresses.
• BCC can be checked to send a blind copy of each e-mail to one or more e-mail recipients.  Multiple BCC e-mail addresses must be separated

with a comma (,) or semicolon (;). Unlike CC, BCC recipients will not see each other's e-mail address.
• Subject is the subject that appears on the e-mail when received by this client on general mailings that do not include a message ID tag. You

may insert variables within the subject to create a mail merge if you have selected Use variables in e-mail on the Variable Settings screen.
• Message File should contain a full pathname to the file containing the HTML message if you selected the Send e-mails as HTML option. If you

are sending e-mails in text format, leave this field blank. To browse to the file that you want to select, clear the contents of Message File and

click Edit HTML File (see below).
• Message is the message that will appear in the body of the e-mail received by this client on general mailings that do not include a message

ID tag.  Click Edit Text to enlarge the area for editing the message, and then click Update to save the changes or Cancel to discard any

changes.  You may insert variables within the message to create a mail merge if you have selected Use variables in e-mail on the Variable

Settings screen.
• If you are sending e-mails in text format, click Edit Text to enlarge the area for editing the message, and then click Update to save the

changes or Cancel to discard any changes.
• If you are sending e-mails in HTML format, click Edit HTML File to use the PDF-eXPLODE HTML Editor to edit the HTML file specified in

Message File, or to create a new HTML file if the Message File option is blank. You may optionally use another HTML editor and specify the

Message File above.

Exploded File Details

Set the default name and folder for exploded PDF files, and options for inserting a cover page. These settings override those specified on the

Mail Settings screen and any Default Message ID Tag screens.

• Exploded File Name will replace the e-mail address in each exploded PDF file name with text of your choice. 

 
Example: The exploded PDF files created by PDF-eXPLODE are named according to the e-mail recipient and, optionally, the date and time of

creation.  For example, an e-mail sent to nancy@pdf-explode.com on January 28, 2009 at 1:23 PM will have an attachment PDF file named:

 
        nancy@pdf-explode.com090128_132300.pdf

 
If you enter Invoice in this field then the resulting attachment PDF filename will be:

 
        Invoice090128_132300.pdf 

 
After being e-mailed, the exploded PDF filename will be the same unless you select Suppress DATE_TIME on exploded filename, in which case

the filename will be:

 
        Invoice.pdf  

• Exploded File Path allows you to select a folder where exploded PDF files will be saved (i.e. archived).  Type the desired pathname (e.g. C:

\Documents and Settings\Nancy\My Documents\Archived PDF-eXPLODE Files) or click Browse to locate and select the desired path without

typing it.
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• Cover Sheet specifies whether to insert an existing PDF file into each exploded PDF, and specifies the full pathname to the selected PDF. 

The selected PDF may be any number of pages. Use this feature for such applications as including a generic newsletter or promotion in every

PDF file created by PDF-eXPLODE. Note: This cover sheet is in addition to any cover sheet defined in General Settings, unless you also have

a cover sheet defined for the Default Message ID, which takes precedence.Select the checkbox to enable insertion of the coversheet, or de-

select the checkbox to disable this feature.
• Select whether to position the Cover Sheet PDF in the Front or Back of the exploded PDF file or to include it in an e-mail as a Separate

attachment.
• Click Browse to navigate to the desired PDF file.

Tips

• You may use this feature in combination with the the Default Cover Sheet PDF defined in General Settings for cover sheets inserted in the

Front or Back of the exploded PDF files. Both cover sheets will be included.
• If you select to include both the Default Cover Sheet PDF as a Separate attachment and also specify a Cover Sheet PDF as a Separate

attachment on a Default Message ID Tags screen, Client Details screen or a Client-specific Message ID Tags screen, the default cover sheet

attachment will not be included.

Exploded PDF Security

• Select Protect Resulting PDF document to apply security settings as defined on the Security Settings options. This field, and the following

password fields, will be disabled if No Encryption is specified in security settings.  If a general password is specified on the Security Settings

screen or on a Default Message ID Tag screen and this option is not selected, the specified client will receive an unprotected PDF.
• User Password is a client-specific password for viewing a protected PDF file that is an override to the password specified on the Security

Settings screen or on a Default Message ID Tag screen.  You may override this password for a client-specific message on a Client-specific

Message ID Tags screen.  User Password must be different than Owner Password to protect the document against users changing the

document's permissions.
• Owner Password is a client-specific password for manipulating permissions in a protected PDF file that is an override to the password

specified on the Security Settings screen or on a Default Message ID Tag screen.  You may override this password for a client-specific message

on a Client-specific Message ID Tags screen.

1. Click Apply Client to save your changes and remain in PDF-eXPLODE Options.

 
-or-

 
Click Save to save your changes and exit PDF-eXPLODE Options.

 
-or-

 
Click a different option in the Options List on the left to discard changes and remain in PDF-eXPLODE Options.

 
-or-

 
Click Cancel to discard unsaved changes and exit PDF-eXPLODE Options.

Edit Client Details

1. Click an existing client.
2. Click Edit Client.
3. Make your desired changes.

 
Note: To edit the To E-Mail Address, you must delete and re-create the client details.

4. Click Apply Client to save your changes and remain in PDF-eXPLODE Options.

 
-or-
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Click Save to save your changes and exit PDF-eXPLODE Options.

 
-or-

 
Click Cancel to discard unsaved changes and exit PDF-eXPLODE Options.

Delete Client Details

1. Click an existing client.
2. Click Remove Client.
3. Click Yes to confirm the deletion or No to cancel.
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Client-specific Message ID Tags
Client-specific Message ID Tags allow you to define the subject and message specific to both a particular type of document and a specific client. For example,

you could define a Default Message ID Tag named "Invoice" and, in addition, define a Client-specific Message ID Tags named "Special Invoice" to send to

clients requiring special attention.  The Client-specific Message ID Tags override the Default Message ID Tag screen and the Client Details screen.

To begin, start PDF-eXPLODE.

Open Client-specific Message ID Tags

1. On the Printer menu, click PDF-eXPLODE Options....
2. In the Options List, click the plus sign (+) to the left of Mail Settings.
3. Click the plus sign (+) to the left of Clients.
4. Click the plus sign (+) to the left of the specific client for whom you want to add a client-specific e-mail message.

Create a Client-specific Message ID Tag

1. If there are no existing message ID tags, click New Message ID.

 
-or-

 
If there are existing message ID tags, click any existing message ID tag.

2. Click the button labeled New.
3. Complete the following fields: Client Details

• Client ID or E-mail Address is a displayed for reference only.
• Message ID is the client-specific Message ID tag used to identify this set of options in the PDF-eXPLODE tag inserted into your report or

document. The Message ID may not include any spaces.
• Select Apply E-Mail Notification to receive an e-mail notification (called a "read receipt") when a recipient reads an e-mail sent by PDF-

eXPLODE. You must also choose Notify me on Read on the General Settings screen for this option to take effect. Note that not all e-mail

servers support this option and also a recipient may optionally deny sending a read notification.
• Select Apply E-Mail Flags to set the Importance and Sensitivity flags specified on the General Settings screen. Note that some e-mail clients,

such as Outlook Express, do not display all of the e-mail flags.
• Select Send e-mails as HTML to format e-mail messages using HTML. Using HTML enables you to format e-mail messages using fonts and

images, etc. If you do not select this option, e-mails will be sent as text (i.e. without formatting such as fonts, etc.) An HTML editor is provided

with PDF-eXPLODE, or you may use another editor and specify the file to be used.

• Choose Print if you want to print documents. Note: If security is applied to a PDF then printing will not occur. Only one copy may be

printed.Choose ONLY (don't E-Mail) to print documents with this message ID but not e-mail them

 
-or-

 
Choose ALSO ( print and E-Mail) to print in addition to e-mailing the documents. 

• Select a printer from the dropdown list of available printers.
• Do not use a message id like PRN, which results in PDF-eXPLODE trying to create a file with an invalid filename. The following device names

are reserved by Windows and cannot be used as a filename: CON, PRN, AUX, NUL, COM1, COM2, COM3, COM4, COM5, COM6, COM7, COM8,

COM9, LPT1, LPT2, LPT3, LPT4, LPT5, LPT6, LPT7, LPT8, and LPT9.

Specific E-mail Settings

• Sender E-mail can be filled in if you want to override the default sender e-mail address specified on the Mail Settings screen.

  The Sender Name can be whatever name you wish to appear in the From field as viewed by recipients of your e-mail.

  Undeliverable e-mails may return error notification e-mails to this address, which can be used to help clean your e-mail list

and re-send important documents.  Enter a name followed by an e-mail address within angle brackets, for example:John Smith

<jsmith@smithcompany.com>

As an alternative to entering sender e-mail address here, a variable may be used to provide the sender e-mail address. For example, if the e-

mail address is contained in variable 3, enter <var3>.
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• CC can be checked to send a copy of each e-mail to one or more e-mail recipients.  Multiple CC e-mail addresses must be separated with a

comma (,) or semicolon (;). Unlike BCC, recipients will see each other's e-mail addresses.
• BCC can be checked to send a blind copy of each e-mail to one or more e-mail recipients.  Multiple BCC e-mail addresses must be separated

with a comma (,) or semicolon (;). Unlike CC, BCC recipients will not see each other's e-mail address.
• Subject is the subject that appears on the e-mail when received by your clients. You may insert variables within the subject to create a mail

merge if you have selected Use variables in e-mail on the Variable Settings screen.
• Message File should contain a full pathname to the file containing the HTML message if you selected the Send e-mails as HTML option. If you

are sending e-mails in text format, leave this field blank. To browse to the file that you want to select, clear the contents of Message File and

click Edit HTML File (see below).
• Message is the message that will appear in the body of the e-mail received by your clients.  Click Edit Text to enlarge the area for editing

the message, and then click Update to save the changes or Cancel to discard any changes.  You may insert variables within the message to

create a mail merge if you have selected Use variables in e-mail on the Variable Settings screen.
• If you are sending e-mails in text format, click Edit Text to enlarge the area for editing the message, and then click Update to save the

changes or Cancel to discard any changes.
• If you are sending e-mails in HTML format, click Edit HTML File to use the PDF-eXPLODE HTML Editor to edit the HTML file specified in

Message File, or to create a new HTML file if the Message File option is blank. You may optionally use another HTML editor and specify the

Message File above.

Exploded File Details

Set the default name and folder for exploded PDF files, and options for inserting a cover page. These settings override those specified on the

Mail Settings screen, any Default Message ID Tag screens and the Client Details screen.

• Exploded File Name will replace the e-mail address in each exploded PDF file name with text of your choice. 

 
Example: The exploded PDF files created by PDF-eXPLODE are named according to the e-mail recipient and, optionally, the date and time of

creation.  For example, an e-mail sent to nancy@pdf-explode.com on January 28, 2009 at 1:23 PM will have an attachment PDF file named:

 
        nancy@pdf-explode.com090128_132300.pdf

 
If you enter Invoice in this field then the resulting attachment PDF filename will be:

 
        Invoice090128_132300.pdf 

 
After being e-mailed, the exploded PDF filename will be the same unless you select Suppress DATE_TIME on exploded filename, in which case

the filename will be:

 
        Invoice.pdf  

• Exploded File Path allows you to select a folder where exploded PDF files will be saved (i.e. archived).  Type the desired pathname (e.g. C:

\Documents and Settings\Nancy\My Documents\Archived PDF-eXPLODE Files) or click Browse to locate and select the desired path without

typing it.

 
 

• Cover Sheet specifies whether to insert an existing PDF file into each exploded PDF, and specifies the full pathname to the selected PDF. 

The selected PDF may be any number of pages. Use this feature for such applications as including a generic newsletter or promotion in every

PDF file created by PDF-eXPLODE. Note: This cover sheet is in addition to any cover sheet defined in General Settings.Select the checkbox to

enable insertion of the coversheet, or de-select the checkbox to disable this feature.
• Select whether to position the Cover Sheet PDF in the Front or Back of the exploded PDF file or to include it in an e-mail as a Separate

attachment.
• Click Browse to navigate to the desired PDF file.

Tips

• You may use this feature in combination with the the Default Cover Sheet PDF defined in General Settings for cover sheets inserted in the

Front or Back of the exploded PDF files. Both cover sheets will be included.
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• If you select to include both the Default Cover Sheet PDF as a Separate attachment and also specify a Cover Sheet PDF as a Separate

attachment on a Default Message ID Tags screen, Client Details screen or a Client-specific Message ID Tags screen, the default cover sheet

attachment will not be included.

Exploded PDF Security

• Select Protect Resulting PDF document to apply security settings as defined on the Security Settings options. This field, and the following

password fields, will be disabled if No Encryption is specified in security settings.  If a general password is specified on the Security Settings

screen or on a Default Message ID Tag screen or on a Client Details screen and this option is not selected, the specified client will receive an

unprotected PDF.
• User Password is a client-specific password for viewing a protected PDF file that is an override to the password specified in Security Settings

or on a Default Message ID Tag screen or on a Client Details screen.   User Password must be different than Owner Password to protect the

document against users changing the document's permissions.
• Owner Password is a client-specific password for manipulating permissions in a protected PDF file that is an override to the password

specified on the Security Settings screen or on a Default Message ID Tag screen.

1. Click Apply to save your changes and remain in PDF-eXPLODE Options.

 
-or-

 
Click Save to save your changes and exit PDF-eXPLODE Options.

 
-or-

 
Click a different option in the Options List on the left to discard changes and remain in PDF-eXPLODE Options.

 
-or-

 
Click Cancel to discard unsaved changes and exit PDF-eXPLODE Options.

Edit a Client-specific Message ID Tag

1. Click an existing message ID.
2. Click Edit.
3. Make your desired changes.
4. Click Apply to save your changes and remain in PDF-eXPLODE Options.

 
-or-

 
Click Save to save your changes and exit PDF-eXPLODE Options.

 
-or-

 
Click Cancel to discard unsaved changes and exit PDF-eXPLODE Options.

Delete a Client-specific Message ID Tag

1. Click an existing message ID.
2. Click Remove.
3. Click Yes to confirm the deletion or No to cancel.

Rename a Client-specific Message ID Tag

• To rename a message ID you must delete it and re-create it.
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HTML Editor
HTML Editor enables you to create e-mail messages formatted in HTML, allowing you to use fonts, colors, images, etc. You may optionally use another HTML

editor and specify the HTML file name in Default E-Mail Settings, for a specific type of mailing on a Default Message ID Tags screen, for a specific client on a

Client Details screen or for a client-specific e-mail message on a Client-specific Message ID Tags screen.

 

Basic Editing Steps

1. To begin, click Edit HTML File.
2. If you have not yet specified a Message File, the Open dialog is displayed. Navigate to the desired folder and enter the name of the file you

would like to create and click Open. If you omit a file name extension, it will default to .html.
3. Edit and format the message using the toolbar buttons (explained below) to enter HTML commands.
4. When you are finished editing, click the Save button or select Save from the File menu to save your changes.
5. Select Close from the File menu to return to PDF-eXPLODE.

Toolbar Buttons

The toolbar buttons display a tooltip when you hover the mouse over the button. Following is a description of each button in the order they appear, with

subheads to reflect the button groupings. You may insert variables within the message to create a mail merge if you have selected Use variables in e-mail

on the Variable Settings screen. For example, if you want to personalize a message with the recipient's first name, which is in variable 4, you could enter Dear

<var4>:.

File

• Save: To save the HTML you are editing, click Save or press CTRL+S.
• Preview: To preview the HTML message as it will appear in the e-mail message, click Preview. Click Preview again to continue editing.

Edit

• Cut: To remove text and save it to the Windows Clipboard, highlight the text and click Cut or press CTRL+X.
• Copy: To copy text to the Windows Clipboard, highlight the text and click Copy or press CTRL+C.
• Paste: To paste the contents of the Windows Clipboard at the cursor location, click Paste or press CTRL+V.
• Delete: To delete a portion of text, highlight the text and click Delete or press CTRL+X.
• Undo: To undo the last change, click Undo or press CTRL+Z.
• Redo: To redo the last undone change click Redo or press CTRL+Y.
• Find: To find text, click Find or press CTRL+F and enter the text to search for. To find the next instance, press F3.

Emphasis

• Bold: To add bold emphasis to a portion of text, highlight the text and click Bold or press CTRL+B.
• Italic: To italicize a portion of text, highlight the text and click Italic or press CTRL+I.
• Underline: To underline a portion of text, highlight the text and click Underline or press CTRL+U.
• Strikethrough: To strike out a portion of text, highlight the text and click Strikethrough.

Insert

• Insert Paragraph: To insert a paragraph at the cursor location, click Insert Paragraph or press CTRL+P and begin typing.
• Insert link to Web image: To insert an image at the cursor location, such as a logo or photo, click Insert link to Web image and enter a URL for

the desired image. The image cannot be on your local computer - it must be at a URL location accessible from the recipient's e-mail, such as a file on

your website.
• Insert Web address link: To insert a link to a web address at the cursor location, click Insert Web address link and enter the URL.
• Insert E-mail address link: To insert a mail-to link at the cursor location, click Insert E-mail address link and enter an e-mail address.

• Insert Quick Text: You can create and insert named blocks of text using the Quick Text feature.To create, edit or delete a Quick Text, click

Insert Quick Text to open the Quick Text dialog.To create a Quick Text, enter a Name and Text and then click Add.
• To edit a Quick Text, select a Quick Text in the list, edit Text and click OK.
• To delete a Quick Text, select a Quick Text in the list and click Delete.
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• To add a Quick Text to the Insert Quick Text dropdown list, select a Quick Text in the list and click Favorite.
• To insert a Quick Text at the cursor location, click Insert Quick Text, select the desired name and click Insert.
• To insert a Favorite Quick Text at the cursor location, click the dropdown arrow next to Insert Quick Text and select the desired name.

• Insert Heading: You can create headings up to six levels deep.To insert a heading at the cursor location, click the dropdown arrow next to Insert

Heading and select a heading level. Then type the heading.
• To insert another heading at the same level you can just click Insert Heading (not the dropdown arrow) as a shortcut.
• To format existing text as a heading, highlight the text and click the dropdown arrow next to Insert Heading to select a heading level, or click

Insert Heading to select the current heading level.

Font

• Select Font: To apply a font to a portion of text, highlight the test and select a font name from the dropdown list.
• Select Font Size: To apply a font size to a portion of text, highlight the test and select a size name from the dropdown list. You can select a relative

size by selecting a numbers preceded by a minus (-) or plus (+) sign, or an absolute point size by selecting a number without a leading sign. A

relative size will make it the specified number of point sizes smaller (-) or larger (+) than the size of the preceding text.
• Select Font Color: To apply a color to a portion of text, highlight the test and select a color or define a custom color.

Alignment

• Align Left: To left-align a paragraph, highlight the paragraph (beginning with <p> and ending with </p>) and click Align Left.
• Align Center: To center a paragraph, highlight the paragraph (beginning with <p> and ending with </p>) and click Align Center.
• Align Right: To right-align a paragraph, highlight the paragraph (beginning with <p> and ending with </p>) and click Align Right.
• Justify: To justify a paragraph, highlight the paragraph (beginning with <p> and ending with </p>) and click Justify.
• Indent Text: To indent a block of text, highlight the text and click Text Indent.

Organization

• Unordered List: To insert a bulleted list at the cursor location, click Unordered List.
• Ordered List: To insert a numbered list at the cursor location, click Ordered List.
• Insert New List Item: To insert a new item into an unordered or ordered list, click Insert New List Item.
• Horizontal Line: To insert a horizontal rule at the cursor location, click Horizontal Line.

Other

• New Line: To enter a carriage return and begin a new line, press SHIFT+Enter .
• Select All: To select all text, press CTRL+A.

 

Keyboard Shortcuts

Key Function

CTRL+A Select all text

CTRL+B Apply bold to selected text

CTRL+C Copy to clipboard

CTRL+F Find

CTRL+I Apply italics to selected text

CTRL+P Insert paragraph

CTRL+S Save HTML file

CTRL+X Cut selected text

CTRL+V Paste from clipboard

CTRL+Y Redo last undone change

CTRL+Z Undo last change

F1 Display help
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F3 Find next instance

SHIFT+Enter Insert carriage return



 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

Preparing a Document



 

 

PDF-eXPLODE Tag

PDF-eXPLODE Tag

You insert PDF-eXPLODE tags in your documents to indicate which settings to use when exploding and e-mailing documents.

Tag Format Rules

A PDF-eXPLODE tag must be formatted according to specific rules.

A PDF-eXPLODE tag must begin with a <pdfexplode> open tag and end with a </pdfexplode> close tag.

Within the open <pdfexplode> tag and the close </pdfexplode> tag you must specify a valid filename or a valid e-mail address.

You may optionally specify multiple e-mail addresses separated with a comma (,) or semicolon (;).   Only the first Client ID e-mail address will be used to search for a Client

Details screen or on a Client-specific Message ID Tags screen.  Also, only the first Client ID e-mail address will be used in naming the attachment PDF file.

You may optionally precede the first Client ID or e-mail address with a Message ID tag followed by a pound sign (#).

You may optionally precede the first Client ID or e-mail address, or an optional Message ID, with up to five variables followed by a percent sign (%).  Variables must be

separated with a comma (,).

You may not include spaces within a PDF-eXPLODE tag  (exceptions: when using Variables, a value may contain spaces; when using you have selected Full Format as the

Default E-mail Address Format).

The case of the open <pdfexplode> tag and the close </pdfexplode> tag must match.

The case of the text between the open <pdfexplode> tag and the close </pdfexplode> tag can be upper or lower.

The entire tag must have a standard Windows font applied to it, such as Times New Roman or Arial .

A tag must fit entirely on a single line.  Apply a small font size to minimize the risk of a tag not fitting entirely on a single line.

Document Tagging Rules

A PDF-eXPLODE tag must be inserted within a document according to specific rules.

Only pages that begin with a PDF-eXPLODE tag will be included in exploded PDF files, so the page header is the ideal location to ensure each page is included.

You may include multiple PDF-eXPLODE tags per page if you want to send a page to multiple recipients.

All of the pages associated with the same e-mail address will be combined into a single PDF file.

You may change the color of the tag to white to make it invisible in the resulting document.

Note: An empty tag, for example <pdfexplode></pdfexplode>, will create an exploded PDF file with a name determined as follows:

If Suppress DATE_TIME on exploded filename is not selected in General Settings and Exploded File Name is blank in Mail Settings, then the file name will be

yyyymmdd_hhmmss.pdf, where the name represents the system date and time when the file was created.

If Suppress DATE_TIME on exploded filename is selected in General Settings and Exploded File Name is blank in Mail Settings, then the file name will be .pdf.

If Suppress DATE_TIME on exploded filename is selected in General Settings and Exploded File Name is not blank in Mail Settings, then the file name will be the name

specified in Mail Settings followed by .pdf.

If Suppress DATE_TIME on exploded filename is not selected in General Settings and Exploded File Name is not blank in Mail Settings, then the file name will be the name

specified in Mail Settings with yyyymmdd_hhmmss.pdf appended.

The location of the exploded PDF file will be the path specified in Mail Settings, or if blank then the Default Document Path specified in General Settings.

PDF File Name Rules

Windows does not permit the following characters to be used in file names: < > : " / \ | ? *

Period (.) may not be used as the first character in a file name.

PDF-eXPLODE does not permit the following characters to be used in file names: # % ~

Example Tag to Specify a PDF File Name

<pdfexplode>MyDocument</pdfexplode>

Example Tag to Specify an E-mail Address

<pdfexplode>JohnSmith@SmithCompany.com</pdfexplode>

In addition to the Standard e-mail format shown above, you may optionally specify in General Settings that e-mail addresses in tags are in Full Name format.

Example Tag to Specify an E-mail Address in Full Name Format, will be sent to JohnSmith<Sales@SmithCompany.com>:

<pdfexplode>John Smith!Sales@SmithCompany.com</pdfexplode>

Example Tag to Specify an E-mailable Fax Number

Many fax servers allow you to send a PDF e-mail attachment by forming an e-mail address with the fax number followed by the fax server domain name, for example:

<pdfexplode>9780001234@MyFaxServer.net</pdfexplode>

In addition to the Standard e-mail format shown above, you may optionally specify in General Settings that e-mail addresses in tags are in Fax Sending format.

Example Tag to Specify an E-mail Address in Fax Sending Format, will be sent to 9780001234<JohnSmith@MyFaxServer.net>:

<pdfexplode>9780001234!JohnSmith@MyFaxServer.net</pdfexplode>

Example Tag to Specify an E-mail Message

<pdfexplode>Invoice#JohnSmith@SmithCompany.com</pdfexplode>



 

 

The above example assumes you have created a Default Message ID Tag named Invoice.  In addition to defining a default e-mail message for invoices, you may also have

created a Client-specific Message for invoices under the Client Details for JohnSmith@SmithCompany.com.

 

Example Tag to Specify Multiple E-mail Addresses

<pdfexplode>JohnSmith@SmithCompany.com,AccountsReceivable@SmithCompany.com</pdfexplode>

Remember that the tag must fit entirely on a single line in the document. You may reduce the font size to fit, if necessary.

Separate e-mail addresses with a comma (,) or semicolon (;).

Files are named based on the first tag unless you specify a variable as the filename (see example below). Therefore, do not use multiple different tags that begin with the same e-

mail address or else PDF-eXPLODE may mix up the documents. For example, if you have the following tags:

<pdfexplode>John@SmithCompany.com,Mary@SmithCompany.com,Susan@SmithCompany.com</pdfexplode>

<pdfexplode>John@SmithCompany.com,David@SmithCompany.com,Andrew@SmithCompany.com</pdfexplode>

change the order of one of the tags so that John is not first in both tags, for example:

<pdfexplode>John@SmithCompany.com,Mary@SmithCompany.com,Susan@SmithCompany.com</pdfexplode>

<pdfexplode>David@SmithCompany.com,John@SmithCompany.com,Andrew@SmithCompany.com</pdfexplode>

Example Tag to Specify a CC or a BCC e-mail address

You can include CC and BCC e-mail addresses in a tag in addition to the TO address(es).

To include one or more CC e-mail addresses, precede the CC addresses with a tilde (~), for example:

<pdfexplode>JohnSmith@SmithCompany.com,~BobJones@SmithCompany.com,MaryBrown@SmithCompany.com</pdfexplode>

To include one or more BCC e-mail addresses, precede the BCC addresses with BC-, for example:

<pdfexplode>JohnSmith@SmithCompany.com,BC-BobJones@SmithCompany.com,MaryBrown@SmithCompany.com</pdfexplode>

If you use both CC and BCC, the CC addresses must come before the BCC addresses:

<pdfexplode>JohnSmith@SmithCompany.com,~BobJones@SmithCompany.com,BC-MaryBrown@SmithCompany.com</pdfexplode>

You cannot include CC or BCC address without a TO address.

Example of Multiple Tags per Page

<pdfexplode>President@SmithCompany.com</pdfexplode>

<pdfexplode>Vice-President@SmithCompany.com</pdfexplode>

<pdfexplode>Director@SmithCompany.com</pdfexplode>

This is an alternative if a tag with multiple e-mail addresses does not fit on a single line.

 

Example Tag to Specify a Folder and File Name Using Variables

<pdfexplode>November,Invoice_12345%JohnSmith@SmithCompany.com</pdfexplode>

In the above example, an invoice will be e-mailed to John Smith and the PDF will be archived in \November\Invoice_12345.pdf, where the PDF file folder name is in variable 1

and the PDF file name in variable 2.

You can specify the pathname to \November\Invoice_12345.pdf, for example, G:\Invoices, using the File Path on a Default Message ID Tag,  Client Details or a Client-specific

Message ID Tag screen. If you are not using either Message IDs or Client IDs or these have been left blank, you will need to specify an exploded file path under Mail Settings

for use.  If those File Path settings are blank, the most recently used folder will be used, which may or may not be the Default Document Path on the General Settings screen.

Remember that the tag must fit entirely on a single line in the document. You may reduce the font size to fit, if necessary.



 

 

 



 

 

Tagging a Microsoft Word Document
Microsoft Word® documents are text-based documents.  A text-based document is a document in which you type literal tags to indicate which pages go in

which PDF files.  For example, you might send different sections of a document to different people.  All of the pages associated with the same e-mail address

will be combined into a single PDF file.  The best way to insert a PDF-eXPLODE tag into a Word document is to type it directly into the page header.  Only

pages that begin with a PDF-eXPLODE tag will be included in a PDF file.

Insert a PDF-eXPLODE Tag

• To type text in the page header of a Microsoft Word document, on the View menu click Header and Footer.  After typing the text, click anywhere

outside the header.
• Type a PDF-eXPLODE tag with the name of the desired PDF file, which may be an e-mail address if you want PDF-eXPLODE to send the PDF file as an

e-mail attachment.  The following example PDF-eXPLODE tag will not be sent by e-mail:

 
<pdfexplode>mydocument_</pdfexplode>The following example PDF-eXPLODE tag contains an e-mail address:

<pdfexplode>JohnSmith@SmithCompany.com</pdfexplode>
• The case of the open <pdfexplode> tag and the close </pdfexplode> tag must match, so always use lowercase to be safe.
• A tag must fit entirely on a single line.  Apply a small font size to minimize the risk of a tag not fitting entirely on a single line.
• The entire tag must have a standard Windows font applied to it, such as Arial or Times New Roman.
• You may change the color of the tag to white to make it invisible in the resulting document.
• You may include multiple PDF-eXPLODE tags per page if you want to include a page in multiple exploded documents.
• All of the pages associated with the same filename will be combined into a single PDF file.
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Tagging a Crystal Report
Crystal Reports® stores documents in .rpt files, which are data-driven documents.  A data-driven document is one in which you insert placeholders where

you want information from the fields in your database to appear within the report.  If your database has a field containing e-mail addresses, you can send

different sections of a report to selected e-mail addresses.  For example, if you are sending invoices, you might insert the e-mail address of your clients'

account payable contact into the invoice page header so that each invoice is sent to the correct client contact person.  All of the pages associated with the

same e-mail address will be combined into a single PDF file.

Instead of using a database field to supply the e-mail address, you may optionally use a text object for the e-mail address if you always send a report to the

same e-mail address, for example you may have a report you always send to JohnSmith@SmithCompany.com.  Another alternative is to use a formula

field to supply the e-mail address if you have special requirements for computing an e-mail address, for example if-then logic to select from among several e-

mail addresses for each client. In any case, you insert a PDF-eXPLODE tag into a Crystal report using a text object.

Insert a PDF-eXPLODE Tag

• On the Insert menu Click Text Object.
• Place the text object in a Page Header section beginning at the left margin. Make sure the selected section is not suppressed.
• Within the text object, type the following:

<pdfexplode></pdfexplode>

If you are using a Message ID Tag, for example invoice, then your tag would look as follows:

<pdfexplode>invoice#</pdfexplode>

• In the Field Explorer, click on the desired e-mail field.  You may use a database field, formula field or even a running total field.
• Drag the selected field and drop it immediately before the close </pdfexplode> tag.
• Make the text object as wide as necessary for the entire PDF-eXPLODE tag to appear in its entirety for the longest e-mail address. Click and drag the

right handle of the text object all the way to the right margin.
• A tag must fit entirely on a single line.  Apply a small font size to minimize the risk of a tag not fitting entirely on a single line.  Select the text object

and click Format Text on the Format menu.  Click the Font tab, enter 6 for the Size and click OK.
• The entire tag must have a standard Windows font applied to it, such as Arial or Times New Roman.  Select the text object and click Format Text

on the Format menu.  Click the Font tab, set Font to Arial and click OK.
• You may change the color of the tag to white to make it invisible in the resulting document.  Select the text object and click Format Text on the

Format menu.  Click the Font tab, set Color to White and click OK.
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Tagging a Microsoft Access Report
Microsoft Access® reports are data-driven documents.  A data-driven document is one in which you insert placeholders where you want information from

the fields in your database to appear within the report.  If your database has a field containing e-mail addresses, you can send different sections of a report

to selected e-mail addresses.  For example, if you are sending invoices, you might insert the e-mail address of your clients' account payable contact into

the invoice page header so that each invoice is sent to the correct client contact person.  All of the pages associated with the same e-mail address will be

combined into a single PDF file.  The easiest way to insert a PDF-eXPLODE tag into an Access report is using a text box.

Insert a PDF-eXPLODE Tag

•
Click the Text Box tool  in the toolbox.

• Click the upper left corner of the page header section to indicate where you want to place the text box.
• Place the insertion point in the text box and type an expression that includes the e-mail address or the name of the field containing the e-mail

address, and an optional Message ID Tag.  For example, if your database has a field named Email, you would enter the following expression

="<pdfexplode>" + [Email] + "</pdfexplode>"

If you are using a Message ID Tag, for example invoice, then your tag would look as follows:

="<pdfexplode>invoice#" + [Email] + "</pdfexplode>"

• Make the text field as wide as necessary for the entire PDF-eXPLODE tag to appear in its entirety for the longest e-mail address. Click and drag the

right handle of the text field all the way to the right margin.
• A tag must fit entirely on a single line.  Apply a small font size to minimize the risk of a tag not fitting entirely on a single line.  Right-click the text

box, click Properties and click the Format tab.  Enter 6 for the Font Size.
• The entire tag must have a standard Windows font applied to it, such as Arial or Times New Roman.  Right-click the text box, click Properties

and click the Format tab.  Set Font Name to Arial.
• You may change the color of the tag to white to make it invisible in the resulting document.  Right-click the text box, click Properties and click the

Format tab.  Set Fore Color to White.
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Tagging a Microsoft Word Mail Merge Document
Microsoft Word® provides a Mail merge Wizard that enables the creation of data-driven documents.  A data-driven document is one in which you insert

placeholders where you want information from the fields in your database to appear within the report.  If your database has a field containing e-mail

addresses, you can send different sections of a report to selected e-mail addresses.  For example, if you are sending invoices, you might insert the e-mail

address of your clients' account payable contact into the invoice page header so that each invoice is sent to the correct client contact person.  All of the pages

associated with the same e-mail address will be combined into a single PDF file.

The best way to insert a PDF-eXPLODE tag into a Word document is to type it directly into the page header.  Only pages that begin with a PDF-eXPLODE tag

will be included in a PDF file.

Insert a PDF-eXPLODE Tag

• On the Tools menu, point to Letters and Mailings and click Mail Merge Wizard.
• Follow Steps 1-3 of the wizard.
• When you reach Step 4 of the wizard, click Header and Footer on the View menu.
• Type the PDF-eXPLODE open tag as follows:

 
<pdfexplode>

• In the wizard window, click More items... to display the Insert Merge Field dialog.
• Click the e-mail address field and then click Insert and Close.
• Type the PDF-eXPLODE close tag so that the completed tag looks as follows, where Email_Address would be the actual field name in your

database:

 
<pdfexplode>«Email_Address»</pdfexplode>

• Within the text object, type the following:

<pdfexplode></pdfexplode>

If you are using a Message ID Tag, for example invoice, then your tag would look as follows:

<pdfexplode>invoice#</pdfexplode>

• A tag must fit entirely on a single line.  Apply a small font size to minimize the risk of a tag not fitting entirely on a single line.  Select the tag and click

Font on the Format menu.  Click the Font tab, enter 6 for the Size and click OK.
• The entire tag must have a standard Windows font applied to it, such as Arial or Times New Roman.  Select the tag and click Font on the Format

menu.  Click the Font tab, set Font to Arial and click OK.
• You may change the color of the tag to white to make it invisible in the resulting document.  Select the tag and click Font on the Format menu. 

Click the Font tab, set Font color to White and click OK.
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Tagging an R&R Report
R&R Report Writer® stores documents in .rrw or .rsw files, which are data-driven documents.  A data-driven document is one in which you insert placeholders

where you want information from the fields in your database to appear within the report.  If your database has a field containing e-mail addresses, you can

send different sections of a report to selected e-mail addresses.  For example, if you are sending invoices, you might insert the e-mail address of your clients'

account payable contact into the invoice page header so that each invoice is sent to the correct client contact person.  All of the pages associated with the

same e-mail address will be combined into a single PDF file.

Instead of using a database field to supply the e-mail address, you may optionally use a text field for the e-mail address if you always send a report to the

same e-mail address, for example you may have a report you always send to JohnSmith@SmithCompany.com.  Another alternative is to use a calculated

field to supply the e-mail address if you have special requirements for computing an e-mail address, for example if-then logic to select from among several e-

mail addresses for each client. In any case, the easiest way to insert a PDF-eXPLODE tag into an R&R report is using a calculated field.

Insert a PDF-eXPLODE Tag

• If your report does not already have a Page Header band, insert one.  On the Insert menu Click Create Band Line.  Click Select Band, leave the

default band as Page Header and click OK.
• Create a calculated field that includes the field with the e-mail address.  On the Calculations menu click Calculated Fields and then click New. 

Enter a field name such as PDFeXPLODE and then enter an expression such as the following example, where you will replace e_mailAddr with the

actual name of the field in your report that contains the e-mail address.  When you are finished, click OK and Close.

"<pdfexplode>" + e_mailAddr + "</pdfexplode>"

If you are using a Message ID Tag, for example invoice, then your tag would look as follows:

"<pdfexplode>invoice#" + e_mailAddr + "</pdfexplode>"

• Place the cursor in the upper left corner of the report at the beginning of the first Page Header line and insert the field you just created.  On the

Insert menu click Field.  In the Insert Field dialog box, click Insert and Close.
• Make the text field as wide as necessary for the entire PDF-eXPLODE tag to appear in its entirety for the longest e-mail address. Click and drag the

right handle of the text field all the way to the right margin.
• A tag must fit entirely on a single line.  Apply a small font size to minimize the risk of a tag not fitting entirely on a single line.  Select the text field

and click Font on the Format menu.  Enter 6 for the Size and click OK.
• The entire tag must have a standard Windows font applied to it, such as Arial or Times New Roman.  Select the text field and click Font on the

Format menu.  Set Font to Arial and click OK.
• You may change the color of the tag to white to make it invisible in the resulting document.  Select the text field and click Font on the Format

menu.  Set Color to White and click OK.
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Print Options
When you click Print on the File menu in most Windows Applications, you may select PDF-eXPLODE as your "printer."  Doing so instructs PDF-eXPLODE to

intercept the output rather than sending it to a printer.  After capturing your printer output, PDF-eXPLODE displays the Print Options dialog.

Using the print Options dialog, you can save the document to a "master" PDF file instead of printing it.  In addition to creating the master PDF file, you can

explode the master PDF file into separate "exploded" PDF files each of which may contain all or just selected pages from the master PDF file according to the

PDF-eXPLODE Tags you inserted.  Finally, you may optionally e-mail the exploded PDF files.

All of the steps in the process described above (create, explode, e-mail) can be initiated by the user manually or can be set to run unattended in an

automated fashion, called "Silent Mode".  You select whether PDF-eXPLODE operates in silent mode on the General Settings screen. 

In silent mode, the Print Options dialog is not displayed. If you print a document containing no PDF-eXPLODE tags, the Print Options dialog will display

regardless of the Silent Mode setting (except on PDF-eXPLODE Printer Server and PDF-eXPLODE Report Server, since dialogs cannot be displayed on the

workstation.)  When silent mode is not selected, you may interact with the Print Options dialog to control the process of document creation, exploding and

e-mailing.  The remainder of this help topic describes the options on the Print Options dialog when silent mode is not selected and you are operating PDF-

eXPLODE manually.

Summary

You may optionally specify the following PDF document properties. 

• File Name is both the Windows filename and the PDF file title given to the master PDF file.
• Author might be useful for identifying your name or your company's name.
• Subject might be useful for identifying the type of document, such as "Invoice" or "Monthly Statement".
• Keywords might be useful for searching documents.

Not to be confused with Windows file properties, PDF file properties may be viewed using either of the following methods:

• Click Start, point to Programs, point to Accessories, and then click Windows Explorer.
• Select the folder in which you saved your PDF file.
• Double-click the PDF file you created to open it in your PDF viewer
• Click Document Properties on the File menu.
• When you are finished viewing the properties, click OK and then click Exit on the File menu.

-or-

• Right-click Start and click Explore.
• Select the folder in which you saved your PDF file.
• Right-click the PDF file you created and click Properties.
• Click the PDF tab.
• When you are finished viewing the properties, click OK.

Quick Mail

Quick Mail enables you to convert a document into a PDF file and send it as an e-mail attachment without placing a PDF-eXPLODE tag in the document.  This

is handy for ad-hoc and one-off documents.  Any PDF-eXPLODE tags embedded in the document will be ignored and PDF Security Settings will be ignored, i.e.

the behavior will be the same as when Security Mode is set to Do Not Secure any PDF document after exploding.

The Print Options dialog will display if you print a document that contains no <pdfexplode> tags. To disable this feature, select Suppress Quick Mail when

the document has no <pdfexplode> Tags in General Settings.

• Select Send PDF created as attachment to Quick Mail to enable Quick Mail options.
• To: is the e-mail address to which the e-mail will be sent.  Multiple e-mail addresses must be separated with a comma (,) or semicolon (;). Click

To: to display a list of e-mail addresses from your Microsoft Outlook address book. Select one or more addresses and click Continue to enter the

addresses or click Close to cancel.
• Cc: works like To:, enabling you to send a copy of the e-mail to one or more e-mail recipients.  Multiple CC e-mail addresses must be separated with

a comma (,) or semicolon (;). Unlike BCC, recipients will see each other's e-mail addresses.
• Bcc: works like To:, enabling you to send a blind copy of the e-mail to one or more e-mail recipients.  Multiple BCC e-mail addresses must be

separated with a comma (,) or semicolon (;). Unlike CC, BCC recipients will not see each other's e-mail address.
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• Select Send e-mails as HTML to format e-mail messages using HTML. Using HTML enables you to format e-mail messages using fonts and images,

etc. If you do not select this option, e-mails will be sent as text (i.e. without formatting such as fonts, etc.)
• Subject is the subject that appears on the e-mail when received by your clients.
• Attachment is the pathname of an optional PDF file to attach (in addition to the PDF file created by PDF-eXPLODE). You may enter the pathname or

click Browse to select a file.
• Message is the message that will appear in the body of the e-mail received by your clients. If you selected Send e-mails as HTML, click Create

HTML Message to write a message using the HTML Editor, and when you are finished save your changes and close the HTML Editor to return to this

dialog. If you did not select Send e-mails as HTML, type your message in the area provided.
• Select e-mail flags for Importance and Sensitivity, if desired. Note that some e-mail clients, such as Outlook Express, do not display all of the e-mail

flags.

• Set Importance to Normal, Low or High. Press the Delete key to clear the selection.
• Set Sensitivity to Normal, Personal , Private or Confidential. Press the Delete key to clear the selection.

• Select Read Receipt to receive an e-mail notification when a recipient reads the e-mail sent by PDF-eXPLODE. Note that not all e-mail servers

support this option and also a recipient may optionally deny sending a read receipt.

Options Button

Click Options to to display and/or modify options including General Settings, Security Settings and Mail Settings, as well as Default Messages, Client Details

and Client-specific Messages. 

Explode Later Button

Click Explode Later to save the master PDF file in the PDF-eXPLODE queue if you want to explode and e-mail it later.  PDF-eXPLODE will automatically select

Suspend Printer on the Main Menu, placing a check mark next to the menu item.  When you de-select Suspend Printer, processing continues.  If silent

mode is selected on General Settings, the pending documents are exploded and e-mailed immediately.  If silent mode is not selected then the Print Options

dialog is displayed to allow the user to control processing.

Explode Now Button

Click Explode Now to explode the master PDF file into separate PDF files according to the embedded PDF-eXPLODE tags.  If the Quick Mail options are

specified, the exploded PDF files will be e-mailed.  If Quick mail is not selected, the exploded PDF files will be e-mailed according to the Mail option on General

Settings. The the current mail option is displayed for easy reference and may be changed by clicking the Options button.

Create PDF Button

Click Create PDF to save the master PDF file without exploding it or e-mailing the exploded PDF files. This button does not appear when you have selected

Send PDF created as attachment to Quick Mail.

Create & E-Mail PDF Button

Click Create & E-Mail PDF to save the master PDF file and explode and e-mail the exploded PDF files.  This button only appears when you have selected

Send PDF created as attachment to Quick Mail.

Cancel Button

Click Cancel to remove the document from the PDF-eXPLODE queue without saving, exploding or e-mailing.
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Logging Operations
When you use PDF-eXPLODE to send PDF attachments by e-mail, you may want to check the status of the e-mails you sent.  Below are some suggested ways

to monitor the status.

View the Exploded PDF Files

You may view the PDF file you just created if you have a PDF viewer installed such as the free Adobe Reader, available at www.adobe.com. If you do not have

a PDF viewer installed, PDF-eXPLODE includes one named Foxit Reader, which can be accessed from the Logging and Utilities screen.

1. Click Start, point to Programs, point to Accessories, and then click Windows Explorer.

 
-or-

 
Right-click Start and click Explore.

2. Select the folder in which you save your exploded PDF files. Tips

 
• The Default Document Path is displayed on the General Settings screen.
• If the Default Document path is blank, the location will be in the folder named PDFs located in the directory

where the PDF-eXPLODE program is installed, which is typically C:\Program Files\PDF-eXPLODE\PDFs.
3. Double-click the PDF file you want to view to open it.  (The filenames will be your clients' e-mail address followed by the date and time.)  Close

your PDF viewer when done.

View the PDF-eXPLODE Log Files

It is a good idea to check the PDF-eXPLODE Log Files to be sure no errors occurred sending the e-mails.  Log files are accessible from the Logging and

Utilities screen.

View the Return Address Inbox

It is a good idea to specify an e-mail account in the Sender Name field of Mail Settings where you can easily check for return e-mails when delivery

problems occur.  Delivery errors may result if someone typed an e-mail address incorrectly, or an employee is no longer be with a company.  Undeliverable e-

mails may also return error notification e-mails to this address.

For example, you might create an e-mail account named "CustomerService@YourCompany.com".  Then, in the Sender Name field you would enter the

following (be sure to leave a space before the left angle bracket (<):

Customer Service <CustomerService@yourcompany.com>

For e-mails that are delivered successfully, the recipient will see the sender name in their "From" field.  However, if the receiving e-mail server encounters an

error, it may send a reply e-mail back to this e-mail account to help you resolve the error.  You may need to work with your intended recipient to resolve the

error if their e-mail server has blocked your e-mail for some reason.
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Run PDF-eXPLODE from a Command Line
If you need to explode and e-mail an existing PDF file, the proper way to do so is with a command line - do not print an existing PDF file from a PDF viewer to

the PDF-eXPLODE printer. Running PDF-eXPLODE from a command line can be used to accomplish such applications as:

• Using Window Task Scheduler to automate the execution of PDF-eXPLODE

• Exploding an existing PDF created by another application. For example:Some applications (e.g. SQL Server™ Reporting Services) print an image

rather than text which makes the PDF-eXPLODE tags unreadable. So, instead of printing to PDF-eXPLODE you need to export to PDF and then

explode the PDF.
• Some applications produce smaller PDF files so it may be advantageous to create the PDF using software other than PDF-explode.

Command Line Format

"Program Path" -PRINTFILE"master PDF path"

 
For example:

 
"C:\Program Files\PDF-eXPLODE\PDF-eXPLODE.exe" #PRINTFILE"C:\Program Files\PDF-eXPLODE\PDFS\PDF-eXPLODE.pdf"

 
Note that there is no space between -PRINTFILE and the name of the PDF.

Detailed Instructions

• First, you must verify the location of the PDF-eXPLODE.exe file on your computer. If you accepted the default folder location when you installed

PDF-eXPLODE, the PDF-eXPLODE.exe file is probably located at: C:\Program Files\PDF-eXPLODE\PDF-eXPLODE.exe
• If you do not find the PDF-eXPLODE.exe file at that location, search for the file and make a note of the full path.

•

Do one of the followingWindows Vista:  Click the Start button , point to All Programs, click Accessories, and then click Run.
• Windows XP, 2000,2003:  Click the Start button, and then click Run.

 

1. In the Run dialog box, type a double quote (") followed by the full pathname for the PDF-eXPLODE.exe file (including the file name) and

another double quote, or click Browse to locate it.
2. At the end of the path, type a space, and then type the switch #PRINTFILE, a double quote, the full path of the master PDF file to be exploded

and another double quote.  Note that there is no space between #PRINTFILE and the name of the PDF. For example, you can type (or copy,

paste and edit the following example):

 
"C:\Program Files\PDF-eXPLODE\PDF-eXPLODE.exe" -PRINTFILE"C:\Program Files\PDF-eXPLODE\PDFS\PDF-eXPLODE.pdf" Tips

• Switches and parameters are not case-sensitive. For example, -PRINTFILE is the same as -printfile.
• Remember to include one blank space before the -PRINTFILE switch and NO SPACE after it.
• If the PDF pathname has spaces in it, enclose the complete name in quotation marks — for example, "C:\Program Files\PDF-eXPLODE\PDFS

\PDF-eXPLODE.pdf".

1. Click OK.
2. The exploded files are created in the same folder as the master PDF, unless there is an Exploded File Path specified in Mail Settings.
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System Requirements

• Operating System: Microsoft® Windows® XP, Windows 2000, Windows Server® 2003, Windows Server® 2008, Windows Vista® or Windows 7
• Hard Drive: Minimum 52.5MB of free disk space, plus additional space for PDF files created
• RAM: At least 64MB of available memory, more during PDF creation. The size of the PDF that can be created is limited by the amount of available

memory.

 



 

 

 



 

 

 
PDF File Creation Properties
PDF-eXPLODE includes a process that creates PDF files.  While every effort has been made to optimize the resulting PDF files for the widest audience, there

may be times where you need to customize the default properties as noted below.

Properties that affect the creation of PDF files are stored in the file named pdfexplode.properties located in the PDF-eXPLODE program folder (see What's

Installed Where for the specific location).  The properties file may be edited using the Windows Notepad text editor.  It is highly recommended that a backup

copy of the original pdfexplode.properties file be saved before changes are made.

 

Note: Properties are case-sensitive.  You must enter them in the case indicated.

 

To begin, close PDF-eXPLODE if it is currently open.  Navigate to the PDF-eXPLODE program folder and make a copy of the file named pdfexplode.properties

to save as a backup.  Open pdfexplode.properties in Notepad and make changes as necessary and then save the file.

JPEG Compression

To further compress any gray or color raster images using the JPEG method use the -J <quality> property where <quality> may be a value between 0 and

100 (best).  Note that this option has no effect on text, vector images or black & white images, only gray-scale and color raster images are affected. If using a

BMP (for example, a signature), a high value for compression may distort rather than improve quality.

• To reduce the PDF file size and still maintain good quality, set this property as follows:

-J 60

• To increase quality while increasing file size, set this property as follows:

-J 70

• To set very high quality while further increasing file size, set this property as follows:

-J 90

Paper Size

To specify a default paper size format use the -F <format> property where <format> may be a2, a3, a4, a5, letter or legal.

• To set the default paper size format to letter, set this property as follows:

-F letter

• To set the default paper size format to A4, set this property as follows:

-F a4

Rotate Page

The page may be rotated for proper onscreen viewing of landscape pages using the -R <degrees> property, where <degrees> may be 0, 90, 180 or 270. 

• To prevent pages from being rotated, allowing landscape pages to be viewed normally, set this property as follows:

-R 0

Text Print Quality

The dots-per-inch resolution may be varied to affect the quality, size and speed using the -d <dpi>/<dpi>/<dpi> property, where <dpi> may be

a number between 72 and 600.  The first <dpi> number is text resolution, the second <dpi> number is color graphics and the third <dpi> number is

monochrome graphics.  In general, a higher value for <dpi> will produce higher quality output but will cause PDF-eXPLODE to use more memory and take

longer to create a PDF file and the resulting file will be larger.

• For draft quality office work at a resolution of 150 dpi, set this property as follows:

-d 150/150/150

• For higher quality output, for example if your PDF result shows slightly misplaced characters in text (usually horizontally by a tiny amount),  set this

property to 300 dpi as follows:
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-d 300/150/200

• For the highest quality output, for example if your PDF contains high-resolution graphics, set this property to 600 dpi as follows.  Setting text

resolution greater than 300 is not recommended:

-d 300/600/600



 

 

 
PDF-eXPLODE Developer's Website

Please click here to visit this site
 

 
 
PDF-eXPLODE has been in the market for close to seven years. During that time the product has evolved such that it is now one of the best
feature rich product in the market.
 

http://www.pdf-explode.com.au


 

 

 
Mail Settings
 
Fast Start Guide
The purpose of this help topic is to assist users who want to use PDF-eXPLODE to send an e-mail as soon as possible after installing the product before

reviewing all the options and capabilities of PDF-eXPLODE.

Please note the default paper size supported by PDF-eXPLODE is Letter.  If your paper size is different, for example A4, you must edit the PDF File Creation

Properties and set the appropriate Paper Size before proceeding.

Mail Settings

To send e-mails using PDF-eXPLODE, you must set up an e-mail account much like you would in an e-mail client program such as Microsoft Outlook. The steps

below are designed to get Microsoft Outlook users going quickly.  Refer to the Mail Settings help topic for general documentation.

To begin, start PDF-eXPLODE.

Open Mail Settings

1. On the Printer menu, click PDF-eXPLODE Options....
2. In the Options List, click Mail Settings.  You will see the two tabbed forms displayed in the right-hand pane of the PDF-eXPLODE window:

Default E-mail Setting and E-mail Connection Setting.

Default E-Mail Setting

Enter the default e-mail Subject and Message Text you want to appear when your e-mail is viewed by recipients.  You can change them each time you

send e-mail using PDF-eXPLODE, or you can create Subject/Message definitions that are associated with specific types of mailings such as monthly statements

or invoices (called Default Message ID Tags)  or with specific recipients (called Client-specific Message ID Tags).

E-Mail Connection Settings

Click the tab labeled E-mail Connection Setting. To prepare Microsoft Outlook to lookup the proper settings, perform the following steps. Leave the

Outlook screen open to refer to as you fill in the PDF-eXPLODE Mail Settings.

1. Open Microsoft Outlook.
2. Click E-mail Accounts on the Tools menu.
3. Select View or change existing e-mail accounts and click Next.
4. Select the e-mail account you wish to use and click Change.
5. You will see a dialog box like the one below.
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Fill in the following fields in PDF-eXPLODE as described:

• Sender Name: Refer to the Microsoft Outlook screen and enter the value from Your Name (e.g. John Smith) followed by a space, followed by the

value from E-mail Address within angle brackets (e.g. John Smith <jsmith@pdfexplode.com>.
• Outgoing Mail SMTP Server: Refer to the Microsoft Outlook screen and enter the value from Outgoing mail server (SMTP).
• Sign-on Username: Refer to the Microsoft Outlook screen and enter the value from User Name.
• Password: Refer to the Microsoft Outlook screen and enter the same Password. Note that passwords are displayed as asterisks and stored

encrypted for security.

For the next field on the PDF-eXPLODE screen, click the More Settings… button in Microsoft Outlook to bring up the following dialog window, and click on

the tab labeled Advanced.



 

 

• Port: Refer to the Microsoft Outlook screen and enter the value from Outgoing server (SMTP).

For the next fields on the PDF-eXPLODE screen, in Microsoft Outlook click on the tab labeled Outgoing Server to display the following dialog.



 

 

• Authentication Type: Refer to the Microsoft Outlook screen and:

• If the box labeled My outgoing server (SMTP) requires authentication is not checked, select None, otherwise if it is checked:
• If the Option labeled Use same settings as my incoming mail server is selected, select Login.
• If, when you try sending an e-mail using the Login setting, the e-mail does not get sent, select Plain instead of Login.
• If the option labeled Log on to incoming mail server before sending mail is selected, select POP.

• Incoming Mail (POP3) Server: Refer to the Microsoft Outlook screen and if the box labeled My outgoing server (SMTP) requires

authentication is checked and the option labeled Log on to incoming mail server before sending mail is selected, click Cancel in Microsoft

Outlook return to the previous screen and enter the value from Incoming mail server (POP3). Otherwise, leave this field blank.
• Your e-mail connection settings should now look like this:



 

 

• Click Test Connection and check the sender name e-mail account (jsmith@pdfexplode.com in this example) to ensure the test e-mail was delivered

and received. If you do not receive the test e-mail, chances are the settings are incorrect. You may need assistance from your e-mail administrator to

ensure the settings are correct.
• Click Save to save your settings.
• On the Printer menu, click Exit to close PDF-eXPLODE.

E-mailing a Document

At the heart of PDF-eXPLODE is the ability to explode, or separate, a PDF file into individual PDF files to e-mail different people different sections of a

document.

To get your documents where they need to go, you need to inset PDF-eXPLODE tags in the documents to indicate which settings to use when exploding and

e-mailing documents.

Tagging a Document

• Open a short test document in a program such as Microsoft Word or Crystal Reports.
• In the page header, or at the top of the page, type a PDF-eXPLODE e-mail tag in the following format, replacing the example e-mail address

with your own e-mail address.<pdfexplode>jsmith@pdfexplode.com</pdfexplode>
• If you are using Crystal Reports, make sure the entire the tag is visible. (Hint: Click and drag the right handle of the text object all the way to the

right margin.)
• A tag must fit entirely on a single line. Position the tag starting at the left margin. Apply a smaller font size if necessary.
• Apply the Times New Roman font to the entire tag.
• You may change the color of the tag to white to make it invisible in the resulting document. However, we recommend leaving the color black so the

tag is visible until you have fully tested the document.
• The case of the open <pdfexplode> tag and the close </pdfexplode> tag must match, so always use lowercase to be safe.
• Do not include spaces within a PDF-eXPLODE tag.
• Only pages that begin with a PDF-eXPLODE tag will be included in the PDF file attached to the e-mail.
• All the pages associated with the same e-mail address will be combined into a single PDF file.

Printing to PDF-eXPLODE

PDF-eXPLODE will create, explode and e-mail PDF files. The following instructions assume you will create the master PDF with PDF-eXPLODE. However, if you

have an existing PDF created by another process, you can still use PDF-eXPLODE to explode and e-mail it - refer to the instructions for using PDF-eXPLODE

from a Command Line.

• Set the document to print to the PDF-eXPLODE printer.
• Print the document. For testing purposes, we recommend that you select just a few pages.
• If you have not configured PDF-eXPLODE to e-mail in “Silent Mode” in General Settings and the following dialog appears, select Explode Now and

then click Save.
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View the Resulting E-mail

You may view the PDF file you just e-mailed yourself if you have a PDF viewer such as the free Adobe Reader, available at www.adobe.com.  If you do not

have a PDF viewer installed, PDF-eXPLODE includes one named Foxit Reader, which can be accessed from the Logging and Utilities screen.

1. In your e-mail inbox, locate the e-mail you just sent yourself.
2. Open the e-mail and then open the PDF attachment. If you want to use Foxit Reader, first save the PDF attachment to a disk file.
3. Close your PDF viewer when done.

Troubleshooting

• It is a good idea to check the PDF-eXPLODE Log Files to be sure no errors occurred sending the e-mails.  Log files are accessible from the General

Settings screen.
• Check the Inbox for the e-mail account in the Sender Name field of the PDF-eXPLODE Mail Settings where you may find return e-mails when

delivery problems occur.  Delivery errors may result if you typed the e-mail address incorrectly in the document you printed to PDF-eXPLODE.
• The default paper size supported by PDF-eXPLODE is Letter.  If your paper size is different, for example A4, you must edit the PDF File Creation

Properties and set the appropriate Paper Size.
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